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Limitation of Prota shall not be held responsible for any losses caused by
Responsibilities documentation, software, or usage errors.

In addition to Prota License Agreement Terms, it is the responsibility of
the user

e to check of results generated by documentation and software,

e make sure that the users of the software and their supervisors
have adequate technical capabilities,

e make sure that the software is used correctly per the reference
manual and documentation,

Intellectual ProtaStructure is a registered trademark of Prota Software Inc. All
Property intellectual property rights belong to Prota Software Inc.
Documentation, training, and reference manuals, and program
components can not be copied, distributed, and used in violation of the

license agreement.

Trademarks ProtaStructure®, ProtaDetails®, ProtaSteel® ve ProtaBIM® are registered
trademarks of Prota Software Inc. Prota logo is a trademark of Prota
Software Inc.
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Thank you for choosing ProtaStructure. This Quick Start Guide aims to get you up and running quickly.
You should be able to model, analyze and review the results for this simple model in around 1 hour.

User Interface

ProtaStructure 2022 welcomes you with a modern & efficient user interface designed from scratch for
ease of use. The various components of the ProtaStructure user interface are as shown below:

Tab Toolbar

File

Protastructure 2021 /Pro

Quick_Start_Gui

ide_Conc

Complete_RS Beam

Commands for the
selected Tab Toolbar

Review Analyss Design Drawings & Reports BIM Deplay Views Help Beam I
- = - B Edit Wall Load 4. Copy Manual Loads Steel Corrosion Ratio
Propertes Secton  Analysis Result  Edit Member : ;::aﬂ\a:l::d & DeleteManualloads g Deflection/Crack Check Steel Realzation Rato /
I Refresh, Rotate, Zoom I
Ml Stev:2(0) x
ceRxQ 3 .
Search| | #° Plan View
« i structure A @
v rard Layers &
: Display
Structure Tree e Ll AN
E‘/
2 (}
: y | A
) : +
s T i
c sS4 L R o —®
o ) | 4
e €=— Views =
T Storey: 2 (Plan) 7 - = . .
T3 Storey: 2(30) =
& Reports Poeey
£ Detal Previews o L -
4 storeys ) == T P | T W T S i i &
» © 5t 0(+0,00m) ;
» © St: 1(+3.00m, Sm:2,3) j== -
4 © St:2(+6.00m, Sim:1,3) H—r + f 3+ i 3}
+ (| Cokmmes — %
v | Shearwials =
. 1/jem Zﬁg L me— ©
v B2 Y%

Status bar — reveals important information, eg. required action to proceed

3D View

Ribbon User Interface

Toolbar Tab

Building Setout Modeliing Loading Review Analysis Design Drawings & Reports BIM
| p— 4] Recent Projects v Save nep
D) B g o B BY BY & Re
— "\“3 Open Previous Backup E Save As -
New Open ) Load Building Linked Model  Import Import
[ save Thumbnail X| Close Project Model Manager  FromIFC from Revit
Project Quick Start Exte:

(oot}

Display Vi

External

Reference Drawing

rnal Reference Drawin

Imports an architectural plan as reference drawing to
ProtaStructure

Usage

1. Select and load the DXF file.

2. Choose the unit that the drawing has been
areated.

3. Specify the scale and insertion point.

The ribbon consists of several toolbars placed on various tabs. Each toolbar contains related
commands organized into logical & functional groups. Placing the mouse cursor over the command
will reveal the Tooltip explaining how to use the function.

ProtaStructure’
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Generally,  you create  the model  from the left  to right ribbon  tab.
i.e., start with Building Setout > Modelling > Loading > Review > Analysis > Design > Drawings &
Report.

Views
| Review Analysis Design Drawings & Reports BIM Display Views Help
v 3D =
Reset Tile Horizontal Tile Vertical Smart Plan 3D Physical 3D Rebar
Model Model
Window Create View

Create as many views as you need, such as a plan, 3D physical Model, Analytical Model, and 3D rebars.
Views can be organized using smart window layout options.

Customize your work area by docking and floating views. The interface is compatible with multiple
monitors. If you want to make the most of your screenscape, just move one of the views to another
screen.

Structure Tree Search Option

Are you looking for a specific member or object? Type in the member label in the structure tree’s
search box and let ProtaStructure find it for you.

cok gax
i

4 H structure
4 f}€ Storeys
4 0 St 1(+3.00m, Sim:2,3)
4 || columns
v 1C1
v 1C10

Quick Access Toolbar

The Quick Access toolbar displays commonly used commands. Any command can be added to the
Quick Access toolbar by right-clicking on the command = Add to Quick Access Toolbar.

OB - & R
Building Setout Modeg Review Analysis Design Drawings & Reports

12

H o 3 . & H

Load Cases and Seismic Wind and Partition lab Additional Point, Line Pattern Loading
Combinations Parameters Storeyloads  Wall Loads S Definitions
LateralLoads Add to Quick Access Toolbar

Show Quick Access Toolbar Below the Ribbon

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Display Settings E

Colors: Choose the background color and various active E

modeling objects

Grid: Sets the spacing of the grid system to allow ease of
modeling as objects can snap to the intersection of the
grids

Object Snap: Choose the various snap options such as
Start/End/Corner, Perpendicular or Orthogonal Grid, etc.

Graphics Performance: Options that affect graphics
performance. Defaults will give optimal performance.

Active Window Settings & Visual Interrogation

Visual Interrogation: Color-code members to various criteria
such as design status, material types, beam with wall loads.
It is a vital visual tool to check and verify the inputs and
results of the model.

Scene Settings: Control the views’ graphics and switch
on/off the guiding Grids & Coordinate Axis, etc.

Visibility Filters: Filter to the specific storey, Axis, or member
type.

Column Plan Display: The column wall axial, moment &
shear forces to be displayed on the plan view.

Beam Plan Display: Allows brick/partition wall label, load
value & height to be color-coded and displayed in the plan
view. In addition, you can show the total user-defined load
(only after the analysis) & display beam elevation marks.

Grid
Object Snap

Graphics Performance

Background Style:

Top Color:

Selection Color:

Highlight Color:

Insertion Point Color:
Insertion Line Color:

Insertion Line Thickness:

Axis Indicator Color:

Page - 8

[ Orange

Visual Interrogation
Scene Settings
Entity Edges
Hiddenline Properties
Visibility Filters
Column Plan Display
Beam Plan Display
Slab Plan Display

FE Contours

Animation

Active Windows Settings and Visual Interregation

Criteria for recoloring:

Section and Material

Column Sections

Beam Sections

Wall Thickness

Slab Thickness

Materials
Loads

Beam Wall Loads

Slab Additional Dead Loads

Slab Live Loads

Beams with User Defined Loads

Beams using F.E. Slab Loads
Beams Using F.E. Slab Analysis Results

Column Modal Loads
Column Span Loads

Members with Temperature Difference

Design
Design Status

Pile Capacity Status

Joint Shear Chedkd

Member Performance Status
Seismic Isolators

Seismic Isolator Type

Seismic Isolator Lateral Stiffness

Seismic Isolator Axial Stiffness

oK

Slab Plan Display: The plan view shows the dead and live load values.

FE Contours: Shows the FE contours exported from the FE Analysis Post-Processing

Animation: Animate by spinning the model in 3D view

Each modeling window can have separate view settings.

For example, you might want to color the slab live loads on the plan view &, at the same time, color

design status in the 3D view.

ProtaStructure® ProtaSteel’

ProtaDetails’

ProtaBIM’
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Active Windows Settings and Visual Interrogation

Vigual Interrogation

Entity Edges

Hiddenline Properties
Visibility Filters
Column Flan Display

Beam Plan Display T P i 2
Slab Plan Display - Z . i

Animation

Animate Camera St i A 4

~*| Compass
| Coordinate Axis | Grid

Bounding Box

N
ox

In the Scene Settings tab, the grid allows you to switch on/off the grey rectangular grids in the
background. Coordinate Axis will enable you to switch on/off the coordinate symbol.

Layer Toolbars (under Display Tab)

Layer and color settings

= Switch on/off layers and modify the name, color, opacity, line type, line
g weight, font type, and text height.

== (3

Axis Layer Group switch on/off the axes layer

Column Layer Group switch on/off the column layer

|
— et

Wall Layer Group switch on/off the wall layer

d[:[]

i

Partition Wall Layer switch on/off the partition/brick wall layer
Beam Layer Group -_I/J switch on/off the beam layer
Slab Layer Group '_7 switch on/off the slab layer
—
Ribbed Slab Layer Group h'[’:ﬁ switch on/off the ribbed slab layer
= .
Slab Load Layer Group & switch on/off the slab load layer
Slab Strip Layer Group T#1, switch on/off the slab strip layer
Steel Bars Layer :,_. switch on/off the slab reinforcement layer
Steel Member Layer Ziz} Switch on/off steel members such as truss, brace, purlins, girts, etc
Ghost Axis Layer Group ?? switch on/off the ghost axis layer
- =3 . -
Plane Definition Layer P switch on/off the plane definition layer
Text Layer Group TI;C switch on/off all the texts
Footing Layer Group :l_i_l switch on/off the footing layer

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Start Page

When the ProtaStructure is launched, the “Start Page” will appear.

08 9~k
“ SuldogSetout  Modeling  loadng  Review  Andyss  Design  Orawings&Reports EIM  Display  Views  Hep
) [DRrecentpropes - B Iy » \ - Re 2 — = 2 ﬁ’ : =
j J g A# A s td RO ; 9 &* = e f =
New  Open - ” " g

Project Quick Start Materias Settngs Load Lbrares Storeys »

Ot Qa s

A
Resources
Open Project New Project Account ID: 21838
Account Name: @ Getting Started 1.7 What's New
Recent Projects {b

021K 0P KUBUGERBANG V.. 2 -
D \chunfeiDocuments\User Modeh _ 04211, 141122021 a) Help Center B =] Training Videos
141272021 Subaeton eqind

Click 1o extend your subscription R
0421.1PK-3AM1.REV2_R6 Design Guide Tips & Tricks
DchunfeiDocuments\User Model . 0421.1... pe=ns =
14122021

Software Updates News / Videos

01_IP163_4A_GA01_BIkB_03_BF_R6
D \chunfenDocuments\User Modeh . 01_IP1 4 g
32021 Up-To-Date Breaking News! This is just another news text

60.163 12102021

Your software is up-to-date
Quick_Start_Guide_Steel_Complete... Attention! This is an announcmenet text.
CsersiLenovoDocuments ProtaData2022\. Up-To-Date 121102021
141272021

6.0.163

Your software is up-to-date. New videos leaked from ProtaSoftware developer team.
QSG_13 155 Click 1o watch
C\UsersiLenovo\Documents\ProtaData2022:... Big Title 12/102021
1411272021 Tite

Description

Click here v

< >

Bl | Ge: e, Ack: kNm , Do m Xy

The Start Page contains the following functions:

4

%* Open existing project

+» Start a new project

+»* Read Prota News and watch Prota Videos

+» Access Prota Resources such as Help Center, What’ New document & Quick Start Guide
¢+ Read important Notification and download new software Update

¢ View Subscription status

You can always open the Start Page by going to the Help tab > Start Page.

Software update is checked automatically when there is internet connection.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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» Click Open Project in the Start Page & the Open Project dialog will appear.
Here is the explanation of the functions in this dialog :
Open Project...
Project Data Folder: 1 Quick_Start_Guide_Concrete_Complete
- Jsers \barag Documents ProtaData 2033, 2 -6 Made By:
Choose / Create Folder 3 Explore 4 Checked by
9 Al Projects Al Releases - Member Concrete Rebar Steel
Column C30/37 Grade 500 (Type 2)
Most Recently Used Projects 7 0 A-Z Date Shearwal C30/37 Grade 500 (Type 2)
x Ty Beam C30/37 Grade 500 (Type 2)
: Slab C30/37 Grade 500 (Type 2)
Quick_Start_Guide_Concrete_Complete >
Quick_Start_Guide_Steel_Complete 5 ! | Rb Sb ol i Grade 500 (fype 2)
i85 Footing C30/37 Grade 500 (Type 2)
Link Grade 500 (Type 2)
Prota Structure R4.0 +Q Codes:Eurocode 2 (SG).Eurocode 1 (SG).Eurocode 3 (SG)
Number of Storeys:4
Project Last Saved Date:24/04/2019 11:02:12 8
(2] v X
Help oK Cancel

1. The Project Data Folder is the main folder where the project models are stored.
The project model consists of several files stored in a single folder called the Project folder. This
Project folder is created as a subfolder in the Project Data Folder. The project folder name will
always be created precisely the same as the project name.

ik wie

A Data Folder called ProtaData2022 would be installed under My Documents by default.
If required, you can specify a different location by clicking Choose/Create Folder.
Clicking on Explore will open the current Project Data Folder in windows explorer.

You can open existing projects stored in this Data Folder by selecting the project list

After selecting the project, a preview of the project will be shown on the right-hand side
Double-clicking on the project name or clicking OK will open the project.

No

8. You can also read Project Last Saved Date to locate the saved project quickly.

Previous versions of ProtaStructure model can be opened directly in PS 2022:

>
>

YV V VYV V

Click on the dropdown list below to expose the most recent accessed Data Folders.
Tick Most Recently Used Projects to show the recent projects opened quickly.

Firstly, you must choose the correct Data Folder by clicking Choose/Create Folder.

Browse to the desired Data Folder (note data folder is the main folder, not the project

folder)

You will then be able to see the project and open it.

You will be prompted to save the model as another name.

After converting, the project will open.

Newer version projects can’t be opened in older versions of ProtaStructure (not backward

ProtaStructure’

ProtaSteel’ ProtaDetails’

ProtaBIM’
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» Click New Project 1 and type the project name as shown using the * ’ character for spaces.

» Select Singapore (Eurocode) template

MNew Project

Project Code: |Quick_Start_Guide

(Available Characters: A-Z, 3z, 03, _, -)
Templates

Search....

Ireland (Eurocode)
Malaysia (B58110)
Malaysia (EC2, EC8-DCH)
Malaysia (EC2, EC8-DCL)
Malaysia (EC2, EC8-DCM)
Malaysia (Eurocode)
Philippines (ACI318, NSCP2015)
Poland (Eurocode)
Singapore (CP65)
iSingapore (Eurocode)
Thailand (ACI318, IBC)
Turkey (T5500, TBEC2018)
Turkey (TS500, TEC2007)

UK (BS8110)
UK (Eurocode) v
@ Templates: Projects
D:\chunfei\Documents\ProtaData2020), X
(2] v b 4
Help oK Cancel

Templates are used to rapidly establish default model parameters such as design codes, material

properties, member design settings, etc. Alternatively, you can choose to duplicate settings from an
existing project by picking “Projects”.

» Click OK.

The main modeling area will now show a set of rectangular grids in the background.

%

By default, these girds spacing is 1m with a major grid colored darker every 5m. The defaults can be

changed via the Display Setting button %

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Settings Center

The Setting Center can be accessed by clicking on the Settings icon in the Quick Access Toolbar or
from the Display tab (as shown below).

eR -~ ’{h@« Protas ProdsSiuchre 3 :xt:V;tar:ﬁume

Building Setout Modeliing Loading Review Analysis Design Drawings & Reports BIM Display Views Help

= [ RecentProjects v Save -y . . -

lj @ B Hs H P > RS H 90 o ot =
¥ Open Previous Backup E Save As oo ¢

New Open Load Building Linked Model  Import Import External Materials Settings | Layers and Display
@ Save Thumbnail X Close Project Model Manager FromIFC fromRevit Reference Drawing Center | Color Settings Settings

Project Quick Start Materials Settings
The Settings Center centralizes all the program’s default settings, including analysis, design and
detailing, and Units & format settings.

Options

earch Setting e Genersl Language Settings

4 Q) ProtaStructure Environment

Don't Check Model During Member Insertion

Display Language: EE English v

General Angle Step: 5.0¢@ =i

Display Settings Report Language: |ggf English | v
4@ ProtaDetails Environment Length Step: 100 mm

Plan View Direction (Project Based)

Display Member Section Eccentricity Step: 25 mm

Mouse and Cursor Top ® Bottom

Default Line Weight

Object Snap Update AutoSave

Other Update Channel: |OFFICIAL v Automatic Save Interval: 0| 5 | minutes
» Project Preferences (Automatic Save Option will be Disable when Interval is '0'.)

@0 Unit and Format .

N EIE Label You have selected to receive updates from the O;Eﬂ:IL Prompt for Automatic Saving

)| Codes
iH Lateral Loading
[ Lateral Drift & Bracing

v Backup Structural Model

Number of Backups to Save: 3

<>

Tooltip Preferences

| Return License on Shutdown

+ (| Column & Shearwall /| Show Tool Tips
b ¢ Beam Tool tip Delay (sec.): 1.0 Member Tooltip Window
+ ~ Slab
< . w| Show Detailed Tool Tips | Display Icon
»,_ll;ﬁmndatmn -
0 Stairs Tool tip Delay (sec.): 1.0 ispay Member Type
iO] Retrofit Wall | Display Member Label
' g Steel Scttings Theme Selection | Display Basic Properties
> Analytical Model Settings .
Theme: |Office 2013 v 7| Display Al Properties
+ £ Rebar
» gf] Plan Details

== Temnlate Mananement

OK Cancel

For example, when you initially start a project, it's advisable to review the Automatic Save Interval in
the View & Save dialog. By default, “0” means it’s disabled.

» Change the Automatic Save Interval to 10 minutes to ensure the model is auto-saved.

» Untick Prompt for Automatic Saving to set the auto-save to run silently in the background.

Number of Backups to Save

The Number of Backups to Save refers to the automatic & silent additional backup created every full
hour. For example, the 1°t backup file will be created at 9:00 am sharp, 2" backup at 10:00 & 3™
backup at 11:00. At 12:00 pm, the backup will overwrite the 1% backup, and the cycle continues.

The backup zip files can be found in a folder called “Backup” in the same Project Data Folder. The files
name will have the date and time stamp (example shown below)

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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™ « Documents > ProtaData202K > DataBackup

~

~ [ Name

;' QS5G1(R001.00032020.1400).zip

»

» T B
£7 QSG1(R001.00022020.1600).zip

»

» 3.' QSG1(R0O01.00032020.1700).zip

Project Template

The available templates are shown when you start a new project, and you must choose one. You can
reaccess these templates via the Building Setout tab.

Templates Project Settings:
Search Project... Setting Group Active Value
Brazi Codes and Related Parameters Current Project
Hong Kong (COP) _
. Analysis Model Parameters Current Project

Indonesia (ACI318, SN11726) # v ’
Ireland (Eurocode) 1 7l Load Case and Combinations Current Project
Malaysia (BS8110) )

Malaysia (EC2, EC3-DCH) @ Column Design Settings Current Project
Malaysia (EC2, EC8-DCL) |51 Beam Design Settings Current Project

Malaysia (EC2, EC8-DCM)
Malaysia (Eurocode) &7 Slab Settings Current Project
Philippines (ACI318, NSCP2015)

Poland (Eurocode) @ Stair Design Settings Current Project
Singapore (CP65) 3 jili} Retrofit Wall Settings Current Project
Singapore (Eurocode) =) Import )
Thaland (ACI318, T8C) . A Footing Settings Current Project
Turkey (TS500, TBEC2018) -] Expdr'(D fm Slab Additional Load Library Current Project
Turkey (TS500, TEC2007) -
UK (B58110) (fj Beam Wall Load Library Current Project
UK (Eurocode) o

Materials Current Project
My template B @ !
®) Templates: Projects 2 C A

x Select All New Template

Importing an existing Template - refer to step 1,2,3 above

You can change the template of a currently opened project by selecting a different template and
Importing it :

» Pick a Template (1) = Pick Select All (2) = Import (3)

All the settings of the imported template will apply to the current project.

Exporting a new Template - refer to step A, B, C, D above

You can save the settings of your current project as your template by Exporting it :

» Pick New Template (A) = Give it a name = OK - The new template will be created (B)
» Select the new template (B) - Select All (C) = Export (D)

The template will be successfully exported & can be re-used the next time you start a new project.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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Selection Methods

Selection is performed by placing the mouse cursor on a member or Axis in the modeling view.
Although there is no entity to select now, the information is essential as you work through the model.

> Left-click on the entity to select the entity. Selected entities are also highlighted in the Structure
Tree

» To select multiple entities, hold down the CTRL key while you pick them

» You can select entities directly from the Structure Tree

You can drag with the mouse to access further selection options:

» Drag from left to right to create a rectangular box. When you release the mouse button, all
entities wholly contained within the box will be selected
» Drag from right to left similarly, and all the entities that cross its boundaries will be selected

If you right-click the selected entities, you will see a pop-out context menu that allows you to edit and
perform other tasks related to that entity, such as Properties, Delete, etc.

Pressing ESC will deselect all entities.

Zoom & Pan Methods

The useful functions for zoom are just above the structure tree :
» Zoom Window & - Zoom into the area defined by dragging a rectangle.
» Zoom Previous X -> Zoom to the previous view.

» Zoom Extents & - zooms to the selected entities. If no entities are selected, it will
zoom to show all entities.

You will find it easiest to use the mouse wheel to:
» Zoom in - scroll your mouse wheel up
» Zoomout - scroll the mouse wheel down
» Pan (move) - hold down the middle mouse wheel and drag

Modeling Axes

The very first step to building a model is to define axes. Axes intersections then become the nodes at
which members are inserted. Hence, axes must be created correctly. There are three ways to model
axes:

1. Axis toolbar to build axes individually

2. External Reference Drawing to import all axes from the DXF drawing file.

3. Orthogonal Axis Generator to create a system of axes quickly

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Axis / Grid Tool °,
Modeling individual axes is simple using the program’s Dynamic Input System (DIS). i

> Clickon Grid * in the Modelling tab.

There are several insertion methods for the Axis:

Axis X
7 Single Segment allows you to create a straight-line axis by clicking

AlS on the start and endpoint of the Axis.

™~ Multi-segment axis enables you to create a single axis with

Length:
Angle: multiple segments of any shape
Insertion Method: o

A 1 ¢ Curve Axis can be created by specifying the radius

» Ensure Single Segment insertion is selected

» Put the mouse cursor on any of the grey grid intersections & the “Grid Intersection” snap is

shown

. Grid Intersection
ar

> Left-click (& release) to confirm the start point

A “rubberband” will appear as you move your mouse cursor to specify the endpoint

¥

o= 4397 Ly=1714

The length (L) and local angle will be displayed during the rubberband operation. In addition,
the relative distance Ax & Ay to the local UCS will also be shown.

» Press F2 to enable input of the length (L) of Axis via Dynamic Input System (DIS)

» Press TAB to cycle to the following input of angle.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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e The related parameter will be locked if a
value is entered in the textbox. You can unlock by
pressing ESC or pressing the lock icon at the right
of the text box.

Cooo ) e |f atextboxis locked and F2 or ENTER is
pressed, DIS will be deactivated. However,
a rubberband operation now continues with the
locked parameter for ease of use.

¥

Lo = 4509, &y = 3373

. The left figure shows the length L is locked,
so you can freely rotate the Axis without
changing the length.

L=5000 @ .-""

e If both text boxes are locked, pressing ENTER will accept the operation, and the candidate
point will automatically be picked.

e In either of the text boxes, you can use shortcut notation Length<Angle or DeltaX, Delta¥Y
(without the need to switch by TAB.)

Length<Angle . DeltaX,DeltaY h
a000<45 & 6000,2000 [
o &
Moo= 34058, Ay = 2133 for= 3405, Ay = 2133

e Holding down the CTRL key when the rubber band appears will lock the length & angle
increment as defined in Settings Center - ProtaStructure Environment - General > Angle
Step & Length Step input box.

» After specifying the length or angle, pressing ENTER or left-click will accept the endpoint

» Tryinserting a multi-segment axis ™~ by defining points continuously

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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.
A0=4000, &y = -2000

Grid Intersection
+

e Use F2, TAB, ENTER to define destination points as mentioned earlier

e Pressing ESC will cause a smart roll-back. If parameters are locked, the DIS is unlocked, then
the operation is canceled. If a pick-continuous command is active, ESC will unpick points.

> Right-click to end the operation and insert the axis

e You are in axes creation mode when the axis property dialog is shown. Close it if you would
like to end the creation of an axis. The same sentiment applies to all member properties
dialog.

> Insert a curve axis by clicking on the curve axis icon ¢

Click on the 1% point and then the 2™ point

> Move the mouse cursor to the 3™ point that will specify the offset length of the curve.

> Left-click to confirm the 3™ point = Curve axis will be created

e Alternatively, hit F2 to specify the offset length manually.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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External Reference Drawing

Note: This section is for information. A DXF drawing is required if you want to try out this feature.

ProtaStructure lets you load external DXF drawings and show them as ghost reference layers under
your model. The External Reference Drawing button can be found under the Quick Start menu.

Building Setout Modelling Loading Review Analysis Design Drawings & Reports BIM Display Views Help
“ ™ D RecentProjects - B <d N N i [H -
: # H b ;
‘— Open Previous Backup E Save As H m Lo R ‘ o
New Open Merge Building Linked Model Import  Import Import External Materials
%] Save Thumbnail X| Close Project Models Manager FromIFC DXF  fromRevit | Reference Drawing
Project Quick Start Materials

This tool allows you to assign DXF drawings to different stories. Properties like unit, opacity, scale
factor, and offset can be set individually for each imported file. The whole state will be saved along
with the project data and restored; the next time the project gets opened.

Important! The referenced DXF files should be intact to restore the external drawing layer next time
the project gets loaded.

Storey Reference Drawing
Active | Storey N... | File Path Unit | Use Colors | Opacity | Scale Factor | Offset
W 1 C:\Users\User\Documents\SAMPLES_DXF\Architectural\DURULTUCU MIMAR... mm ' = 10 ¥ =-247.86,Y = -708.32
v 2 C:\Users\User\Documents\SAMPLES_DXF\Architectural\DURULTUCU MIMAR...  mm W == 1a K=0Y=10
P 4 C:\Users\User'\Documents\SAMPLES_DXF\Architectural\Architectural_Plan... . |w W —l 1.0 X=0Y=0
mm
am
m
Flease dick "Add” button to add & new external ] « »®
Add X Remove eia Move Import | reference drawing file for a selected storey. L
ihd ok ihd Help F1 OK Cancel
Y

Click Add to select and load a DXF file. The file will be converted into 2D drawing entities inside
ProtaStructure directly upon loading. However, it will not be visible until the Active box is checked.

Active

This checkbox controls the visibility status of the external drawing.

Unit

Please select the correct unit of the DXF file from the table’s unit column right after the file’s loading.
The drawing will be scaled immediately.

Storey No

The imported file will be assigned to the active story initially. You can use the ‘Story No’ column to set
it to any other level. Only one drawing can be attached to a specific storey.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Use Colors

If this field is checked, colors defined in the file will be used; a grayscale drawing is displayed if
unchecked.

Opacity

This parameter controls the opacity of the colors. This field applies only if drawing colors are selected
to be used.

Scale Factor

This factor scales the whole drawing.

Move & Offset

Click the Move button and pick two points on the plan view to move the external drawing. Dynamic
Input functionality (hit F2) can be used here as well. The offset value between the two picked points
will be shown in the Offset column of the table.

BALCUNY M
ct

nd Point e
(WS )
VY
| T

Import

The selected reference drawing can be imported into the assigned story. In this case, the Import DXF
interface will be loaded with a pre-defined level and file unit values. The drawing can be imported to
the existing model in this mode.

A complete model can be developed from scratch in a controlled environment using the External
Reference Drawing interface and Import option.

For more guidance, e.g. 3D Physical Model & 3D Analytical Model import, kindly refer to Prota Help
Center : I[FC and DXF Import Guideline

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Orthogonal Axis Generator

Let us now start the new model by creating the required model axes. We will define multiple axes in
one go using the Orthogonal Axis Generator.
» Select all existing axes that you have created = press Delete (or right-click - Delete)

hj

> Go to the Modelling tab > Select Orthogonal Axis Generator

Refer to the bottom status bar; the displayed text tells you how to proceed.
=+ |Pick the Reference Point (Lower/Left) of the Axis Group...

> Pick the intersection of any two primary grids near the origin (as shown below)

_"_Grid Intersection
ar

Direction 1 axes are placed horizontally with alphabetic labels (incremented from bottom to
top). Direction 2 axes are aligned vertically with numeric labels (incremented from left to right).

» Accept all the default values in the inputs and click OK

Orthogonal Axis Generator ) 0] O] 0
3 3 -
| |
GridInsertion | |
Reference Point - x: 5000 mm -y 5000|mm O t f ®
| |
Insertion Angle : 0.0° | |
| |
Dir-1 : }
Aods Label: | A Step: | i
e | ! ®
Axis Spading(s): | 5000%3 ~ | | I~
| I
Axis Extension Length: 2000 mm | |
| |
Dir-2 Axes | |
Axis Label: |1 Step: o~ I ! -
O | | ®
Axis Spadng(s): |5000%3 : }
Axis Extension Length: 2000 mm | !
| |
| |
| |
~ | \
& i I &
| |
o v x R 1 1
i) ) w (O]
Help F1 oK Cancel + Y

Four horizontal and vertical axes with a 5 m spacing will be created.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Columns Creation

» Pick RC Column icon U

» Use the default size b1 & b2 and eccentricity e2 & e2 is as shown below

Column x

Gen Drop £

C A A
Label: 1c1(8 T Dir-2 Axis
(Storey): | .
Len (Storey): 1 Column
l Reference Point
b1: 500 mm
'
to b2: 250 mm v
b2 — [ . .
8] el: 0mm e2 r Dir-1 Axis
T ' — - — - _
- e2: 0mm ¢ l
Top: '
Bot: | A 1 >l le
el
Bot Insertion Point: 'h
bl
Angle: 0.0°
I Dir: | 1/2 1 2
+ Update > Close

el & e2 is measure from the centroid of the column

Section Manager : Allows access other section types such as circular, “L”, “T”.

ﬂ Column End Condition : Columns ends are fixed by default. You can apply hinges to top and/or
bottom by clicking successively on this icon.

Column Concrete (500x250-C)

Database Project General Properties
Concrete v Section Name: | 500x250-C Material Color [ 192, 192, 192 |v
B 500.0 mm
H 250.0 mm
a 0.0°

Hide Labels

Section Angle: d
Mirror About:  X-X Y-Y

Materials

Conaete [Defauit]

» Insert columns by clicking on the intersection of axes

» Multiple columns can be inserted by dragging a box around the intersection of axes

Using the two methods, create ten columns at positions shown below.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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a ® ®

| | | i

[ | | i
®——| = © &——O

| | | |

i i i i

| | | i

[ | | i

| | | i

| | | i
© (-] | ! @ ©

[ | | i

[ | | i

| | | |

[ | | i

| | | i

| | | i
) —— | | &)
O | | e ®

| | | i

| | | i

| | | i

[ | | i

[ | | i
| o
& o - L

| | | i

A A il L

() (1) )] (4

» Close the column properties. You finish member creation.

Always close member properties when you finish member creation, otherwise you will be
unable to proceed to other functions, such as member selection.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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Walls Creation

» Click on the Wall icon m & the wall properties will appear
» Use the default wall thickness b =250 mm & e =0 mm

The parameters are explained in the diagram below

1wl (3020x230)

>
Ext | Centroid Ext)

e is measured from the centerline of the wall to its centroid. e = 0 means that the
wall coincides with the centroid of the wall.

» Insert three walls by simply clicking on the shearwall’s start and end

Page - 24

centerline of the

s

Q (mm) b: 250 mm
e

0 mm |

ol 125 mm
i H 125 mm

(A [t ]
B__l.

[a ][ 1]
B | 1

l. ! '
®___=—-—-—-———-—=L— _______ o o ® Gen W
_! Label:
1! Len (Storey): 1
|
| I
@ | ‘}3 | ny @
i i
Ext.
=
@__# _________ — e——0) Top 1:
: } I J:
| |
= {| . .Botll:
S e S eI || N
| i !
! { i + Upda
R RS AR L

Ext | & J : Slight extension to lengthen the wall should be kept small; less than
extension cannot support any members, such as beams.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Beams Creation

»  Click on the Beam icon

Label: 181]3

{mm) b: 250 mm

+
e e 0mm

500 mm

e omm

(WPipdete | [3€ o

& & the beam properties will appear.

Pl |

h
|

Y

(S LI
1
}

Is;

Bearn Pararneters

S

Bearn Reference Point

2

Page - 25

e is measured from the beam’s centerline to its sectional area centroid. e = 0 means that the
beam’s centerline coincides with its area centroid.

e-z: +ve value raise the beam from the story level, -ve lowers the beam

End Releases: Beam ends are fixed by default. To release forces (N,V,T,M), check the box(s).

<" Click successively on this icon to hinge & release all moments to the left or right end of beam.

» In the beam properties, use the defaults values b = 250 mm & h = 500 mm (as shown above)

» To create a beam, pick the start and the endpoints by clicking on the intersection of axes

Notice that you can continuously create the beams from the previous beam.

|" 2\:
\ /

e,

i
Y 3 S
et

T

|/.:n

» Right-click to end the beam insertion after inserting the two beams as shown above

—{»)

Multiple beams can also be inserted by dragging a box enclosing the area you want to insert
beams. Beams will automatically be created between columns and walls.

T
T
|
|
|
|
|
¢

i

» Click and drag box enclosing the columns & walls shown above.

ProtaStructure’
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o)
)

ey

)

o/ : ul =/

Seven (7) new beams will be created.

» Insert the rest of the beams by any method as shown below

4 j ShearWalls
w1
w2
1W3

4 (7 Beams
1B1
1610
1B11
1B12
1613
1614
1815
1B16
1817
1B18
182
1B3
164
1B5
186
1B7
1868
189

&7 Slabs
iw” Ribbed Slabs
£ slab Strips

o)
=/

|
\

" ®

®

"/

o
(»)

Check the folder Beams in the Structure Tree to ensure you have inserted a total of 18 beams.
We will now insert a curve beam in the lower right corner of the model.
Click on the curve beam insertion icon d in the Beam Properties dialog

Click on the intersection of axes A/3 and then the intersection of axes B/4 (i.e., start & end of the
beam)

Jﬁ&' bi S {é\ Beam *
| | — Generd | 3
| ) Label: 1819 |
Type: |Normal v
| | (mm) b: 250 mm
A e 0mm
; < W= 1050, &y /51050 = o
. 1€nd 3 @2
’ JEnd 4 @2
T KA/J Curved Beam Insertion:
l £nd Releases
N V2 V3 T M2 M3
1 1
A J .
(3) (4 7 Upcite X cose
L/ N/
ProtaStructure’ ProtaSteel’  ProtaDetails’ ProtaBIM’
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Define the apex distance by simply moving the mouse cursor, and the preview of the curve beam
in grey will show automatically.

» Press F2 to define the apex exactly as -1500 mm & press ENTER

A curve beam will be inserted (segments are automatically created). Check the Structure Tree that
you have modeled for a total of 19 beams.

(7 Beams
1B1
182
183 O =
184
1B5
186
187
1B8
1B9
1B10
1B11
1B12
1B13
1B14
1B15
1B16
1B17
1813 ) —1—®
1B19

. Slabs

i Ribbed Slabs

B ——@®

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Beams Creation using dynamic snap points
Note: This section is optional and is not part of the final model, but you might want to try it anyway.
Secondary beams can easily be inserted using dynamic snap points (without creating axes).

» Click the Beam icon & place the cursor on the edge of the primary beam (avoid the Axis)

g

Place cursor on
edge of beam

TTI : ® e 1B3850x500 o -—®

Notice that snap points on 0.25L, 0.33L, 0.5L, 0.67L, 0.75L will be shown when the cursor is placed on
the beam.

» Click on 0.67L as the start point of the secondary beam.

» Place the cursor on the destination beam

1B3-250x500

Notice that 0.25L, 0.33L, 0.5L, 0.67L, 0.75L & perpendicular point will appear

» Select the desired point as the endpoint of the secondary beam & a new beam will be created

Pressing F2 while the cursor is at any of the snap points will allow input of the exact distance from the
start of the beam.

-gl__:______:____';‘ﬂ“fzﬂ*_ﬁ_ﬂi_____________'______
ol
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Pressing the CTRL key while the cursor is placed on the edge line of the primary beam will expose a
distance increment of 100 mm. Left-click to select the desired distance (while still holding down the
CTRL key).

EEEES

The step increment can be set Building Setout —> Settings Center —> ProtaStructure Environment —
Length Step.

Options
= General
p ° ProtaStructure Environment A Don't Check Model During Member Insertion
Angle Step: 509
v ° ProtaDetails Environment Length Step:
Member Section Eccentricity Step: 25 mm

b o Project Preferences

Handy Tip to adjust the position of columns and beams

You can change the position (eccentricity) of the column and beam by simply selecting it & then
pressing keyboard arrow keys to move in the direction you want.

e ‘ /
/ / . » Select column GC1

S
/ GC1 GC1 » Press right arrow key = to move the
’ ez
(0]

+ column to the right
‘ \ \

The step by which the member is moved can be set in Building Setout —> Settings Center —>
ProtaStructure Environment —> Member Section Eccentricity Step (by default 25mm).

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Load Combinations

Page - 30

Before creating slabs, we need to define the load cases & combinations.

» Go to the Loading tab, click Load Cases and Combinations

Load Combination Editor

P-Delta Analysis

Apply P-Delta Analysis

analysis is performed.

No | Combination

Add Delete

B x Loading
Generator

Approximate slenderness checks using moment
magnification method will not be applied when P-Delta

Load Cases

Totals

Number of Vertical Load Cases =
Number of Lateral Load Cases =
Number of Thermal Loading Cases =
Number of Stage Construction Load =

0
0
0
0
'LL Redr R/C 'Steel
(% v
Help F1 oK

You can add new load cases manually and then load combinations. However, it's easiest to use the
Loading Generator to set up load cases and combinations automatically.

» Pick Loading Generator & use the options as shown below and click OK

Automatic Loading Editor

Create Different Combinations for Steel Member Design

Use Cracked Sections in All Vertical Load Combinations As Well

V.Load Case = 10

H.Load Case = 4

/| Define Dead Load Case (G)

' Define Live Load Case (Q)

V| Define Pattern Loads Automatically
vi=_=_.. v

v ==.. v

| Direction Dependent Pattern Loading

Vertical Load Combinations Horizontal Load Combinations _m IHor\zontaI Load Combinations I

V| G+Q+

) App

Add Vertical Seismic Case

Define Combinations for Roof Live Load (Qr):
Define Combinations for Snow Load (S):

Define Combinations for Rain Load (R):

Stage Cases v

Temperature Loading

| Notional Loading

Wind Loading

Soil Pressure

Pressure Direction

NGx, NQx, NGy, NQy

Wind Load  0: 0.6

| Dir-X Positive (+) v

v D Positive (+) v

EN1991-1-4 (2005) - Singapore Annex

You can choose which combination is used for concrete & steel design separately.

If “Use Cracked Sections” is checked, Section Stiffness Factors will be applied for that load case.
As shown below, all the load cases and combinations will automatically be generated.

ProtaStructure’
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Load Combination Editor
P-Delta Analysis Totals
Apply P-Delta Analysis Number of Vertical Load Cases = 10
Approximate slenderness checks using moment magnification Number of Lateral Load Cases = 4
method will not be applied when P-Delta analysis is performed. Number of Thermal Loading Cases = 0
Number of Stage Construction Load = 0
No | Combination LLRed| R/C | Steel G Q Qpil| Qpi2| Qp21| Qp22| Qp3l Qp32| Qp4l Q42 NGx NQx NGy NQy
1 G+Q v v v 135 1.50 0 0 0 0 0 0 0 0 0 0 0 0
2 G+Qpl v v 4 135 ] 1.50 0 0 0 0 0 0 0 0 a 0 0
3 G+Qp2 v v v 135 0 0 0 1.50 0 0 0 0 0 0 1] 0 0
4 G+Qp3 v v 4 135 0 0 0 0 0 1.50 0 0 0 0 ] 0 0
5 G+Qp4 v v 4 135 o 0 0 0 0 0 0 150 0 0 0 0 0
6 G+Q+Nx v v 4 1.35 1.50 0 0 0 0 0 0 0 0 1.00 1.00 0 0
7 GHix+Q v v 4 1.35 1.05 0 0 0 0 0 0 0 0 1.00 100 0 0
8 G+Q-Hx 4 4 4 135 150 0 0 0 0 0 0 0 0 -1.00 -1.00 0 0
9 GNx+Q v v v 1.35 1.05 0 0 0 0 0 0 0 0 -.00 -1.00 0 0
10 G+Q+Ny v v v 135 1.50 0 0 0 0 0 0 0 0 0 o 1.00 1.00
11 GHNy+Q Cd Cd 4 135 1.05 0 0 0 0 0 0 0 0 0 0 1.00 1.00
12 G+QNy Cd Cd v 135 1.50 0 0 0 0 0 0 0 0 0 o -1.00 -1.00
13 GNy+Q v v v 1.35 1.05 0 0 0 0 0 0 0 0 0 0 1.00 1.00

> Pick OK to save & close the Load Combination Editor.

Slab Creation

> Click on the Slab icon “ and the slab properties dialog will appear

Skab

General Loads
Label: 151|% m
roe: [ (0 [ b ey
h 120 mm
Rel.Level: 0 mm
Conc. Cover: 25 mm
Design Angle: 0.0°

Label Position

1 o e e

Insertion

x Beam Region

" Update ¥ Close

v

o
=

g

12

—

>

Click on the Type box
All the possible Slab Types will appear in pop up menu.

The slab type 1 to 12 relates the slab edge continuity and is
used in the design of the slab reinforced based on the
coefficient / yield-line method.

Type 1 to 12 does not affect the slab load calculation on the
supporting beams, only the design of slab using coefficient
method.

£=I One-way slab. The slab load will only to be
transferred to the 2 supporting beams in the direction
of the span.

The direction of one-way span must be specified in the

Design Angle input box : Angle: 0.0°

Label Position icons activate the slab label and control the slab label’s position.

Insertion method: By default, “Beam Region” is selected. This means the slab will be inserted within
the region bounded by the beams.

» Select Slab Type as 1

For ease in creating this model, we will initially leave Slab Type as 1 for all slabs. Once they have
been created & when we are ready to design the slab, there is a function to automatically set the
correct type for each slab (covered later).

» Enter the slab thickness h = 200 mm and concrete cover = 30 mm

» Inthe Loads tab, enter Service Dead Load = 1.2 kN/m2 and Imposed Load = 3 kN/m2

ProtaStructure’
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Different types of service dead load can be defined via Building Setout - Slab Additional Loads library.

» Position the cursor in the region bounded by beams @GL 3, 4, C, D, and left-click to create a slab.

. - Nt The first slab will be inserted.

" - The yield line shows the tributary area load this is
‘,;_*_‘. automatically calculated onto the supporting beams.
SN By default, slab load calculation is done
o . automatically onto supporting beam using yield-line
. 18 ~ method.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Inserting Cantilever Slabs (Type 12)

Note: This section is optional and is not part of the final model.

Cantilever slabs can be inserted by setting Type = 12 in the slab property. They are inserted by three
clicks - clockwise or counter-clockwise direction does not matter. Cantilever slabs can span more than
one beam or wall.

» Zoom to the top-right corner of the model
» Click on Slab icon & choose Type 12 & enter h = 150mm

» Go to Cantilever tab = Enter L-Cant = 1000 mm (cantilever length)

e —— —— —— @ d
'

Slab X

Slab X

General | Loads General | Loads | Cantlever

Label: d:

b-Slab:

18

=12

h: 150|mm

Rel.Level: 0 mm

Con.Cov: 25mm

Label: (<170

Angle: 0.0°

183-250x500

>
>
>
>

To insert a cantilever slab that does not span the entire length of the beam, we must enter values of d

3',!25’,!

& b-slab in the cantilever slab properties :

182
4=150

1C4 (500x250)

Pick a second point to define the end of the cantilever

Pick the third point to confirm & insert the cantilever

» In Slab Properties, enter d = 1000 mm & b-Slab = 2000 mm

Slab

x

L-Cant.: 1000 mm

I-End:

J-End:

Parapet
Load:

Pick the first intersection of the Axis to define the start of the cantilever

Move the cursor to the side where it is to be inserted = a grey preview will be shown

General | Loads | Cantilever i 2 { 3
d: 1000 mm T -
b-Slab: 2000|mm
L-Cant.: 1000 mm ¢ d > < b )
—
RS14
I€nd: 4150
JEnd: |
RC6 RC7
Parapet —] RB2-P50x506- -

Load:

YV V V V

ProtaStructure’

ProtaSteel’

Pick the third point to confirm & insert the cantilever

Pick a second point to determine the end of the cantilever

Pick the first intersection of the Axis to define the start of the cantilever

Move the cursor to the side where it is to be inserted = a grey preview will be shown

ProtaDetails’
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Polyline Slab/Column Edge

Note: This section is optional and is not part of the final model.
The slab edge line can be used to create irregular slab shapes
> Click Polyline Slab/Column Edge ©7 under Modelling

» Click continuously to define the edge of the cantilever slab.
| |
2 | 3

= 1000, =1 000
1 GC3 |4 GC4

3508 ] p—— {5 Intersection
= =SB8-250x -
____________ L,_,n________________________%f

The method to draw the edge lines is similar to a multi-segment axis.

» At the last point, right-click & pick Finish to end the insertion. The slab edge lines will be drawn

» Click on the Slab icon = Ensure Type = 1 is selected

Y

In the insertion, ensure that Beam Region is selected.

» Click anywhere within the slab edge line, and a new slab will be created.

For regular cantilever slab, it is recommended to use Type 12 in slab properties (instead of slab
edge lines).

The slab/column edge line also includes Circle, Arc & Rectangle and the ability to convert to a
column or slab hole or slab drop. After drawing a closed shape line = Select it = Right-clck 2>
Convert to Column or Slab Hole/drop.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Views Creation

The graphical editor supports multiple windows; this allows you to create different views in separate
windows. The Views tab commands can be used to create new views and to arrange the views.

Loading Review Analysis Design Drawings & Reports BIM Display Views Help
= I = r I & -4
P 0 = P 1\
Reset Tile Horizontal Tile Vertical Smart Plan 3D Physical 3D Rebar
Model Model
Window Create View

> Goto Viewstab = Click 3D Physical Model '~

This command will create a 3D physical model view.
» Click Tile Vertically = This will tile the plan and 3D view side by side

cer ‘Rad

4 H structure
» o s
4T Views
T Storey: 1 (Plan)
To) Storey: 1(30)
i Reports
(53 Detad Previews
4 [ Storeys
» O St:0(+-0.00m)
4 © SE1(+3.00m) 4 H * ok
» | Cokmns :
» | shearwals R
» (7 Beams
» 7 Siabs
o/ Ribbed Siebs
b siab Strips I I
g Doses i #* i i+
<o Trusses
| sraces
LL Purins.
Rors [ | \
/ Frame Members // \
- I - A\
Sritha f #+ i + s

1 Planes

You can select & modify existing members or insert new members in the 3D view the same way as the
plan view.

Note: Alternatively, you can right-click on Views in the Structure Tree or header field of the existing
view tabs to create new views.

4 m Structure Storey: 1 (Plan) m
T T Reset Windows

(R )
(| Axis Tile Horizontal
i —

Tile Vertical

"¢ | Storey: 1(Pla (®| Plan

Smart

Plan
&= Reports 30, 3D Physical Model ’ 3D Physical Model
=3 Detail Previews 30 Rebar Madel \
= I . %‘ Analytical Model | Analytical Model L=
4 [f€ Storeys ‘. i e

Select the curve beam in the 3D view. Notice the same member will be selected in the plan view.
Right-click (to access the context menu) - Properties

Change the depth of the beam h-bot to 600 mm

YV V V V

Click Update and Close the beam properties

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"



B PrroTa g 36

Inserting Storeys & Defining Building Parameters

The final model will be a four-story building. We will now insert the other floors.
» Go to Building Setout 2 Storeys Operations dropdown = Insert story.
» Alternatively, right-click on Storey and pick Insert Storey

€ Select Storey 4 ﬁ(_ =
» © St: 0 ( +-0.00m) E Select Storey
) © St:1(+3.00m) E"‘ Add New Storey

= T Insert Storey

¥ Remove Storey Ef} Generate StOTe‘j

& X Delete Storey EX Delete Members in Storey
r v «
{€] Generate Storey E Remove Storey

70 B“ Edit Storey
; Edit Storey

» Input Total No. of Storeys =4 2 OK

Add Storey

Total No. of Storeys: 4

To add storeys to the top of the building, enter a number greater than the current total. To insert
an intermediate storey, enter a number less than current total.,

» When prompted to confirm = Pick Yes

This automatically inserts stories 2, 3 & 4. We will now edit the information of the stories.

» Pick Edit Storey from the same Storey dropdown menu to enter the Edit Storey dialog

» Hold CTRL key and multiple select Storey 1, 2 & 3. Then click “Define selected stories as similar.”

Edit Storey
h Level . D1 D2 Wwalll Wall2 Imp, Load ;
Info | Storey (mm) (mm) Label | Description (mm) (mm) (kNjm2) (kNjm2) Reduction Similar Storeys
Cd 1 3000 3000 G 15000 15000 0.00 0.00 0.00 2,3
2 3000 6000 1 15000 15000 0.00 0.00 0.00 1,3
» 3 3000 S000 2 15000 15000 0.00 0.00 0.00 2,1
4 3000 12000 R 15000 15000 0.00 0.00 0.00
Imposed LoadReduction Similar Storey
Effective Top Storey No: |4 v 1st Storey Bottom Level: 0 mm
Apply Define Selected Storeys as Similar
I l No.of Rigid Basements: 0 Foundation Depth: 1100 mm
Reset Reset Footing Label: |F
Assume Roof as Normal Storey Footing Description:
Storey Label that defined this fioor level, ) < Y
Help F1 OK Cancel

Storeys 1, 2 & 3 will now be identical. Since we have already inserted members in story 1, these
members will be automatically copied to stories 2 and 3. In addition, changes to a particular similar
level will be applied automatically to all similar stories.
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For storeys to be identical, they must also have the same storey height. In an actual project, STO1 is
the ground floor & will have a shorter storey height & hence should not be made similar.

» Change the member label under the Labels column as shown above, e.g., “G” for STO1 and “R” for
ST04.
STO1 members will be labeled GB1, GC1, etc.

» Click OK to exit and notice that the 3D view shows storey 1, 2 & 3 with identical members.

Storey 4 (Roof) has no members, so that we will generate (copy) members to this storey.

» Pick Generate Storey from the same Storey dropdown

Generate Storey

Source Storey: Target Storey:

o Storey: 1(+3.00m) - x Storey: 1 (+3.00m)
o Storey: 2 (+6.00m) o Storey: 2 (+6.00m)
o Storey: 3 (+9,00m)

{oStorey: 4 (HZ.DOry{)”-

Replace Existing Colums, Walls and Beams at the Same Insertion in Target Storey
Member Type to be Generated
+ Columns ' Slab Loads | Slab Openings
« Shearwalls ' Slabs | Slab Strips
| Beams | Ribbed Slabs | Model Lines

| Braces v Girts

» Under Source Storey, pick Storey 1 & then select Storey 4 as Target Storey
» Click OK, and members will be copied from the ground floor to the roof
» Click Close and check that members are indeed created in storey 4
» Switch to show storey 4 in the plan view by double-clicking on storey 4 in the structure tree
» Create a new slab with the same properties over the lift core since this is the roof level
» Press ESC to deselect all previously selected members
» Right-click anywhere on the plan view to expose the context menu
» Select Member Tables —> Slab Table
The slab table allows you to view & change the parameters of the slabs in a group
b Measure
E Member Tables ' | = Axis Table
F_:v Arrange All Steel Bars fé Column Table
2 wall Table
E Beam Table
B Slab Table
2. Ribbed Slab Table
» Click on the header q (live load), and the entire columns will be highlighted
» Click the Column-wise Edit icon at the top i
» Enter 0.75 kN/m? - press ENTER (all the slabs live load values will be changed)
» Close the Slab Table
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Slab Table
All Storeys Member Search I:“-'; X Close
h g-self g-Dead q Concrete Cover Angle
Slab Type (mm) &k Njm2) Additional Dead Loads (Nfm2) K N/m2) (rom) (Degree) Label vertex Do Na
4 Storey: 4
RS3 1 200 5.00 Enter Value.., 1.20 3.00 30 0.00 0: Center
RS54 1 200 5.00 Enter Value... 1.20 3.00
RSS5 1 200 5.00 Enter Value... 1.20 3.00 | qkNm2)
R56 1 200 5.00 Enter Value... 1.20 3.00
RS7 1 200 5.00 Enter Value... 1.20 3.00 o
RS8 1 200 5.00 Enter Value... 1.20 3.00
R59 1 200 5.00 Enter Value... 1.20 3.00
R510 1 200 5.00 Enter Value 1.20 3.00 V x
" Ue... . N
oK Cancel
R511 1 200 5.00 Enter Value... 1.20 3.00

Wall Loads Library

You can set up pre-defined wall loads and then apply them using a dropdown list when adding the wall

loads.

» Go to Building Setout = Partition Wall Loads g’

Beam Wall Loads Library
Load Name Color Layer Name
100 Brick Wal - Malsysia - Brick
200 Brick Wal - Malaysia =
100 Brick Wal - Sngapore [

200 Brick Wal - Sngapore. [
300 Brick Wal (]
External wall -
140 Block wal -
100 Block wall =
*| x B Duplcate: L L

it Weight (kh/m3)

20.00

Layer Thickness (mm)

130

Total Load (kjm2):

Load value (kN/m2)

2.60

Og  EditMaterids,

@  EdtReferances..

Defaults wall types are automatically set up, but you can add any new user-defined wall type.

» Choose Cancel to exit

We will now insert brick wall loading on the beams in STO1.

>
>

Make the plan view active by clicking on it

Click Load Editor I'1" in the Beam tab that appears.

Double click on STO1 in the structure tree to make it active

Select the bottom-left most perimeter beam along with Grid A/ 1-2

ProtaStructure’

ProtaSteel’
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Member Load Editor

The load editor of the beam will appear once the load cases and combinations are generated.

Uiy CHE - 0O x
| | i
Ll e 4 ¢ p ommm S v
Pont  Full Unform Partial Trapezodal Wall Load Partial Report Zoom Extents oK Cancel
Load Load Jniform Load Load Wall Load
Frame Loads Slab Loads Calculat ~
G 2 v - 0 =
H
571
PRT—— G 4 —
4 G Pick Member Point For Load Position I
 os2
i os2 =
! seif weight 155 V
Q =]
it 6s2 .C*I‘:jl
GSs2 ;H F
p- G=-0.609 0 2500 5000 =5
Load Properties 3 3125 3126 an
Self Weight [ 1 1 |
LoadD 0 250 4750
Label 6
»
Direction Gravity i
Magritude C J X
Measurement Type |P v ] J e
E.d
Insertion R
Update
z R2 =24.88 kN R2 =24 B8 kN
1—» X

1. Load Types
e C(lick to choose the load type to insert, e.g., point load, full uniform load.
o Self-weight & decomposed slab loads are auto-calculated & cannot be edited.
2. Load Case & Loads Folder & Load Properties
e Choose the load case to insert the loads. Existing loads will be listed for the selected load cases.
e C(lick on the load name to select it > Right-click will expose menu options to Edit, Cut, Copy or
Remove the load.
3. Load Properties
e Enter Label, Direction & Magnitude values for the load to be created.
e Select it in the Loads Folder or Loads diagram > Revise values > Click Update to update an
existing load.
4. Loads Diagram
e |t displays the graphical representation of the loads, including self-weight & slab loads
calculated on beams.
e Existing loads can be selected by left-clicking on the diagram > Right-clicking will expose menu
options to Edit, Cut, Copy or Remove the load.
e Click on the beam diagram to insert a load after choosing the Load Type & input values in the
Load Properties.
e The load coordinate system is shown with X, Y, Z arrows. The beam & loads diagram can be
rotated by right-clicking & drag.
5. Load Type filter
e C(lick the Load type icon to toggle on and off the associated diagrams.
6. View Options & Shortcuts

Load Types fiew Options

&> Sold View ‘i 1% | PointLoad :;‘> [ﬂ & ‘:2/' % Load Labels LabelTextHeight 103

£ Analytic View 4= rf" Line Load ¥ Magnitude Labels Magnitude Text Height 109

Transparency Show loads Show Infill Wall Auto Scale Frame Frame End =

@) Orthogonal as merged | £t Areaload | oad as Line Load 2 Labels  Labels  Distancelabels  Distance Text Height 0[5
Common Display Scale Labels

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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e These settings control the rendering of the member, loads graphics, text height, scaling & frame
labels.

e Show Loads as merged /" Loads under the same load case will be combined in a single
diagram. This option must be switched off to edit or remove the load.

o Show Infill Wall as link Load  "': If “on” infill wall will be shown as line usual line loads. The
infill wall will be rendered with actual height and width if the setting is turned off.

Let us insert a 100 mm preset brick wall load on this beam :

Wi & - Beam: GB1 - Loads -
adTypes  View Options
- qt i E & Yield Lines — £
= L £ £ = v X
Point  Full Uniform Partial Trapezodal || Wall Load P [x} Report It nts K Canced
load  load  Unformload  Load

Frame Loads. Slab Loads Calculat

Pick Member For Load

artial
Wall Load

>

gl Self wesght
i 100 Brick Wall - Singapore
Q

<l >

Load Properties

Label | 100 Brick Wal - Singay

=

9 9
Edit Openings \

Average Load Wall - Singapare
= = 250 4750

:E(ur_

wall Unit Weight

h-Start 3000.0 mm

<
i
o
L]
S—
o
B~ F
x |>\

z
R2=4513kN R2=4513kN
pr

GE:mm , Ank kh-m , Dispim

» Pick Wall Load E% under Load Types ribbon.
Notice only the wall load type layer will be active, and all other load types will be switched off
» Ensure G load case is selected in the Loads Folder at the left.

» In the Load Properties, Wall Load Library, pick 100 Brick Wall - Singapore. Note wall height is
preset to 3000mm = storey height.

» Place the mouse cursor on the beam & left click to create the load.
The load will be created and added in the diagram & loads folder.

» Press the ESC key to finish the wall load insertion process. Click OK to save & exit.
Partial wall can be entered by checking selecting Measurement Type = Distance or Percent :
» Enter Start & End Offset
» Alternatively, check Define Wall Length Manually
Wall Opening, e.g. of windows & doors can be inserted by clicking “Edit Openings”.

The brick wall load will be rendered in 2D and 3D views. Notice wall load is also copied to a similar
storey as expected.
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Storey Load Editor

Loads can also be entered for the entire storey, instead of a single member :

» Ensure STO1 is active & no members are selected (press ESC key)

» Go to Loading tab > Pick Load Editor Storey: 1

Building Setout Modeliing Loading Review Analysis Design Drawings & Reports BIM Display Views
R1%s = = => —
- € -3 ——
H [vr| 38 B @ = an
Load Cases and | Load Editor| Wind and Non-Structural Partiton  Slab Additional Slab Load Load Decomposition
Combinations Storey: 1 Storey Loads Component Loads Wall Loads Loads Calculation Method ~ by FE
LateralLoads Load Libraries Slab Loads

The storey load editor is similar to the member’s load editor, except that all the members & loads on
the active storey are shown. The differences are described below.

we s - Storey: 1(+3.00m, Sm:2,3) - 0 x
LosdTypes  View Options
v £ 4 p o @ @ . }? 9 . o ﬁ? -
X g i i L£e 4 £ i W ] =1 v X
Solload Pomt Fulnform  Partal  Trapezodal Walllosd Partal | Pont Unform Wallosd Fullriform  Rectanguar  PolygonUniform WalArea | Report ZoomExtents — OK  Cancel
load  load  Unformload  Load wallosd | Load Load 1 Areaload UniformAreaload  Areaload Load
) FrameLoads Surface Loads ~
G 2 vie » g(? E.l
Show Only Loaded Members A = &4
Member Type 0 '3
7 Beam 2o ~
@ 81 “'[i ?
@ 82 =
= =
@ 83 7 Gl
7 B4 = =
@ G8s =
PR3 e iw(
i@ 100 Brick Wal - Sngap = =8
4 Al PN
' cs1 =
§ selfw E
' self Weht E d
» @ &7 an
» (7 B8 v ‘n? t
Load Properties S~ @
e 4
. T P »,
Label | 100 Brick Wal - Singay ! E’Ifl
Wall Load Lbrary | 100 Bnick Wall - . | v s :
SN
Edit Openings. &
She
o Urst Weight ort
Average Load
= m— = m—
h
e Gt k| (¥ G
h-Start 3000 mm
hénd 3000 mm
Thidmess

1. Load Types
e Surface Loads are loads are area loads that can be applied to slabs and walls
e Self-weight is auto-calculated & cannot be edited.
2. Load Case & Loads Folder
e Choose the load case to insert the loads. Existing loads will be listed for the selected load case.
e Loads folder resembles the Structure Tree, which organizes loads under member type
e Show only Loaded Members: If checked, will omit any members without any loads from listed.
e Expand the folder > Click on the load name to select it > Right-click will expose menu options to
Edit, Cut, Copy or Remove the load.
3. Member Filter
e Toggle visibility of member type in the diagram. For example, if the Beam layer is off, then all
beams & loads applied to beams will be hidden.

We will now copy the brick wall load to all the perimeter beams.
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Wwee & - Storey: 1 (+3.00m, Sm:2,3) - 0 X
Load Types View Options
T | », T c2 a
> sold View Q 2 Show Axis :I;l | Pont Load| érﬂ & t [ / % I Load Labels LabelTextHeight 108 \/ x
£ Analytic View i sm:« . ' UneLoad | e Loa 1 . o i Magnitude Labels  Magnitude Text Height 108 o v
ransparency v Local A v loa Show Scale rame  Frame urface = ance
@ Orthogonal K ShowLocal s | 20 rged | 8 Arestondll | cadiastine toad ! Labels  Labels  Labels  Distancelabels | Distance Text Height 0g
| Common Display Scale Labels »
T— —C L
» @ GBS Al =
4 7 GBs n
T 100 Brick Wall - Singap.
A Gs1 ET;
' self weight —
£ v
Load Properties [
s
Label [ 100 Brick Wal - Singay| || @i,
Wial Load Library | 100 Brick Wall - .. | ?‘X
Edit Openings =]
B
Wal Unit Weight =
Average Load =,
 — | m— I
h s
| A0
h-Start 3000 mm
h€nd 3000 mm

In View Options : Show Loads as merged is by default deactivated, so that the wall loads are shown
separately. Show Infill Wall load as Line Load is by default activated, so wall load is shown as line
load, instead of drawn to actual wall height.

» Choose G load case in Loads Folder.

Y

In Member Filter, toggle off the Slab layer, so the slab and slab area loads are turned off.

o o
In Load Type Filter, toggle off uniform load ?& & Slab Loads , to isolate the wall loads
Select partition wall load in the diagram > Right-click > Copy
Multiple select all the perimeter beams by holding down the CTRL while selecting the beams.

Right-click > Paste > Check the same wall load is pasted correctly.

YV V V VY VY

Go to Load Types tab > Click OK

» Examine the 2D & 3D views to ensure all wall loads are inserted correctly.
Alternatively, wall loads can also be copied in the plan view by the following steps :

» Select beam with wall load inserted

» Right-click > Copy Loads > Select the brick wall load > OK
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B Copy Loads — O x
G(1) Point Load (0) GB1 -G - Wall Load 0-100 Brick Wall - 1
Qo) Area Load ()

Line Load {0)
| Thermal Load (0)

Select\Deselect Al

A

The load case & load type panes act as filters for selecting the load name on the right pane.

» Multiple select the perimeter beams where loads are to be pasted (holding CTRL key)

» Right-click > Paste Loads

Similar steps can be used to delete loads by selecting beams > Right-click > Delete Loads.

Defining Slab Load via Load Editor

You will learn how to insert slab line load.
» Double Click on the Storey 4 in the structure tree (to make Storey 4 active).
» Select the bottom left-most slab, 451 > Click Load Editor

A slab load Editor will appear. It is similar to beam load editor but with additional surface loads type.

TR B - Slab: RS1 ~Loads - o x
Load Types  View Options
i< ] =1 ~
@ 7 v ]
Lol g @ u = & v ox
Thermal Point || Uniform | wall Load  Full Uniform Rectangular Polygon Uniform  Report ~ Zoom Extents OK  Cancel
Load Load Areaload Uniform AreaLoad Area Load
Surface Loads ~
1 v--m
it Self Weight A =
A Pick Start Point 1‘1“
i Q -
i Qload - 151 E
5 End Pt x
=
Load Properties (663 ,]3913) S_ﬁ%
Label [L1 M
=
f
-
Measurement Type | Percent v =
Magnitude (Start) 5.0 kN/m £ z
Magnitude (End) 5.0 kN/m
Insertion 1_201-‘_
s
P
Start Pt Eo
Local Axis + Origin
(654 , 655)
X \ L1
Update 1

GE:mm , Anl: kN-m, Disp:m .

» Go to Loading Types tab > Click Uniform load J&

Note all other load type layers will automatically switch off for clarity.

» In the 3D orientation cube, click on Top E > view direction will change to top
» Ensure G load case is selected

» For Magnitude (Start) & (End) > Enter 5 kN/m
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» Pick the Start point on the load > Pick the endpoint (approximately vertical)

The line load will be created with a default magnitude. To edit the load :

W e & - Siab: RS 1 - Loads -0 x

Load Types View Options

Ll d P m v w8 & vx

Point  Uniform Wall Load  Full Uniform Rectangular Polygon Uniform ~ Report ~ Zoom Extents OK  Cancel
load  Load Areaload Uniform Areaload  Areaload

Surface Loads »

G v‘:dﬁ

it G Load - 151 A
it Self Weight =
= -
Load Properties
Label |L1
Direction Gravity
IMeasu:emen:TyDe Distance “ I
Magritude (Start) 5.000 kN,
Magnitude (End)
/|- Insertion
P dx, (om) | dy, (om) | Magnitude,
1 1000 1000 5
2 1000 4000 5 N {1000 , 1000)
Nal
S
&+ x Edit via Text v ,

Update k X

GE:mm , Anl: kN-m , Disp:m

Press the ESC key to end the line load creation mode.

-
In the Load Filter, switch off Area Load N Area loads will be hidden for clarity

Select the line load name in the load folder or the 3D diagram (rotate the view to suit).

YV V V VY

For Measurement Type > Choose Distance

The Insertion inputs will show the location & magnitude of the load in table. The X & Y inputs are with
reference to the local axis origin

» Change the values as shown above > Click Update > OK to exit the dialog

The line load will also be shown in the model plan & 3D view.

o soer i %)
= RB4- 2505500 1 * 5
|
I\
<= !
|
Innls.
Rt RC2 | m
. Rty ——— = l A7

To edit the slab load, you can select the load in plan or 3D view, Right-click > Properties.

To delete the slab loads, you can select the load, press DELETE key or Right-click > Delete.
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Defining Slab Load (via plan view)

Slab loads can also be defined on the plan view of modeling.

Al
» Go to Loading tab > Click the Point, Line, and Area Loads icon -ll
The slab load properties will appear as shown below.
Sib Load “ | » Select the Line Load icon "
& ||t || @ » Define Angle = 90 degree, length of line load, b1 = 2000 mm and Load
Angle- 50.0° values at start and end, wl = w2 =5 kN/m.
wal: bi:|  2000mm > Pick the intersection of axes A/1 (reference point)
[-Enter Load Manually-] v
s > Press F2 to define the relative coordinates. Enter “2500,2500” which
e —To means AX = 2500 mm & AY = 2500 mm as shown elow
Load Magnitudes:
(At Start) wi: 5.0 kN/m
(At End) w2: 500 kNjm
2500,2500 | @
« Update XCIUSE _I: = ] A - —

Alternatively, you click on 2 points to define the start & end of the line load (without specifying
Angle & b1)

You can insert a partition wall load by clicking on the dropdown menu under “Wall” and select from

> Press ENTER & the slab line load will be created.

\

» Delete this line load by selecting it > press the DELETE key

You may use the external reference drawing to display the architectural drawing at the back of
your model as a guide for creation of members or slab load.
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Slab Opening Creation

Page - 46

You will learn how to define the coordinates and size of the Slab Opening.

» In STO4, zoom to slab between GL A-B/2-3.

&
> Click the Slab Opening/Drop icon = in the Modelling tab, and the slab opening properties
dialog box will appear as the figure below.

Slab Opening
bi: 1000 mm
b2: 500 mm
Type: |Rectangular v
Angle

Drop Region Definition

o« Update| |  Close

>

Define the slab opening horizontal length, b1 = 1000 mm & vertical
width, b2 = 500 mm.

Pick the intersection of axes A/2 as the reference point of insertion
Press F2 to define the relative coordinates

Enter 1000,1000 which means AX = 1000 mm & AY=1000 mm in the

textbox as shown below

» Click Close in the Slab Opening Properties dialog box

ProtaStructure’
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Member Re-labelling for Entire Building
The members are labeled automatically in the sequence they are created.
(i
> To re-label the members systematically, go to Review Tab > Re-label Members
Member Re-labelling Options
Members Sort Reference
Columns and Slabs
v| Columns I V| Retain Compatible Labels Between Storeys I
Left-Top --> Right-Bot Right-Top --> Left-Bot
V| Shearwalls Member Number Start Value: 1
@) Left-Bot --> Right-T Right-Bot --> Left-Ti
A Boss - Left-Bo ight-Top Right-Bo Left-Top
V| Slabs Walls and Beams Modify Prefix Character
HorizontalMembers
v/ Ribbed Slabs
Left-Top --> Right-Bot Right-Top --> Left-Bot
- @) Left-Bot --> Right-Top Right-Bot --> Left-Top
Vertical Members
Left-Top --> Right-Bot Right-Top --> Left-Bot
- () :;gﬁ—Bot --> Right-Top: Right-Bot --> Left-Top
Modify the Postfix
Reference Angle: 0.0°
& V| Group Cantilever Slabs Seperately
Storeys
v Group Members by Direction
First Storey:
Last Storey: @) Sort Rowwise
Sort Columnwise
v All Storeys
v X
OK Cancel

» Select all Members type

» Change all Sort Reference to Let-Bot --> Right-Top.

This means that the left-bottommost member will start with number 1.

» Tick Retain Compatible Labels Between Storeys.

This setting forces the members at the same position to have the same label across all storeys
(e.g., 1C1, 2C1, 3C1 will be at the exact location).

» Click OK.

The members will now be re-labeled systematically with label 1, starting with the left bottommost

member.

It is a common practice to have vertical member (column & wall) retain the same labels between
storeys, whereas this may not be preferred for horizontal member (beam & slab). To achieve this,
you can run the re-labelling twice for different member types with Retain Compatible Labels

checked & then unchecked.

The model is now completed, and we are ready to run the analysis.

ProtaStructure® ProtaSteel’
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Building Analysis

Page - 48

» Go to the Analysis tab —>click Building Analysis : — Pre-Analysis tab

Building Analysis

Unit Weight of Member:
Unit Weight of Blocks:
Coeff.of Thermal Expansion:

Codes:
Eurocode 2 (5G), Eurocode 3 (5G), Eurocode 1 (5G)

Edit Materials

25.00 kM/m3 (Column, Default)
4.41 kiN/m3
0.00005 1f°C

Building Model will be merged with the FE Foundation Model when Building Analysis is repeated.

a

Help F1

Pre-Analysis Model Options Analysis Post-Analysis Reports
Project Parameters and Loading
trr) -
& H £
Loading Wind and Storey
Settings Center CaTarin Load
Materials (Default)
Material Reinforcement Steel Grades
Columns C30/37 Grade 500 (Type 2)
Shearwalls C30/37 Grade 500 (Type 2)
Longitudinal Web Steel Grade 500 (Type 2)
Horizontal Web Steel Grade 500 (Type 2)
Beams C30/37 Grade 500 (Type 2)
Slabs C30/37 Grade 500 (Type 2)
Ribbed Slabs C30/37 Grade 500 (Type 2)
Foundations C30/37 Grade 500 (Type 2)
Links Grade 500 (Type 2)

Close

The Pre-Analysis setting is where the main assumptions of the analysis can be defined :

e Settings Center: Access settings center to review & modify analysis parameters such as the
design code and notional horizontal load

¢ Load Combination: generate, add or modify any load case or load combination sets.

e Wind and Storey Load: automatically generate wind loads, review & input any lateral load.
Automatically generated lateral loads such as the notional horizontal loads will only be
calculated and shown after the analysis.

e Edit Materials: review, add, or change the concrete and steel material of the building.

ProtaStructure’

ProtaSteel’
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We will now define the materials for this project via Building analysis> Pre-Analysis dialog.

> Pick Edit Materials

‘o Material

Default Materials
Foundation Floor

Storey Having Different &
Material

x

Concrete Columns

Concrete Walls

[

Longitudinal Web Bar
Horizontal Web Bar

Concrete Beams

Slabs

Rib

Links

Steel Columns

Steel Beams

Truss Members

Purlin Members

Girt Members

Brace Members

Frame Members

Grade 500 (Tvpe 2)
Grade 500 (Type 2)
Grade 500 (Type 2)
Grade 500 (Type 2)
Grade 500 (Tvpe 2)
Grade 500 (Type 2)
Grade 500 (Type 2)
Grade 500 (Type 2)

¥ OK K cancal

The materials and reinforcement steel grades are shown for all member types. Default Material is
used for super-structure floors. A separate Foundation Floor category is automatically created for
foundation members only.
If a different material is required for a particular storey, a separate material set can be added by

picking the 5

icon. Steel reinforcement grades and diameters are also defined here.

» Pick Column Concrete Grade - select C30/37 — Apply to all members in this storey > OK

Concrete

Concrete
C16/20
C20/25
C25/30
C28/35
C30/37
C32/40
C35/45
C40/50
C50/60
C60/75

% || X

General
Material Name
Material Color
Mechanical Properties
Modulus of Elasticity
Shear Modulus
Poisson's Ratio
Thermal Expansion Coeff.
Unit Weight
Design Parameters
Characteristic Compressive Strength (Fck)
Characteristic Tensile Strength (Fctk)
Material Coeff
Time Dependent Properties
Time Model
Compressive Strength and Stiffness
Creep
Shrinkage

I /| Apply to all members of this material dass in this storey, |

: C30/37
: [ 192, 192, 192 v

1 33000.0 N/mm2

: 13750.0 Nfmm2

0.20

¢ 0.00005000 (1/°C)
;25000 kNjm3

: 30.00 Njmm2

192 N/mm2

¢ 150

: CEBFIB 90

: 0.000

: 0,000

: 0.000

¢ H cancel

» Pick Steel Grade and ensure that Grade 500 (Type 2) is selected and applied to all member types

ProtaStructure’

ProtaSteel’
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Rebar

Rebar

Grade 250 (Plain)
Grade 410 (Type 2)
Grade 460 (Plain)
Grade 460 (Type 1)
Grade 460 (Type 2)
Grade 500 (Type 2)
SBPDN 930/1080
SEPDN 1080/1230
SBPDN 1275/1420

& | X

General
Material Name
Material Color

Mechanical Properties
Modulus of Elasticity
Shear Modulus
Poisson's Ratio
Thermal Expansion Coeff.
Unit Weight

Steel Bar Parameters
Minimum Yield Strength
Ultimate Strength (Fu)
Bearing Strength
Material Coeff
Rebar Symbol
Rib Type
Hook

Prestressed

Page - 50

:  Grade 500 (Type 2)

I 255, 0,0 v

: 200000.0 Nfmm2

76923,0 Njmm2

: 0.30
+ 0.00001200 (1/°C)
: 78.000 kNfm3

500.00 N/mm2
550.00 N/mm2

¢ 0.00 Njmm2

1,15

: H
: Type2 v

Rebar Diameters

¢ Edit... I

I v ;Qr.p!y to all members of this material dass in this slnrayi

¥ oK ¥ cancel

» Click “Edit...” next to Rebar Diameter & the rebar table will appear

Grade 500 (Type 2) Rebar Table

Column
wall
Beam
Slab
Rib Slab
Footing
Links
Longitudinal Web Bar
Harizontal Web Bar
Generic

KK

Show All

Unit: Metric

>

&

Label Diameter (mm)

10 10.0
13 13.0
16 16.0
20 20.0
25 25.0
32 32.0
o

D
H
)

Area (mm2)
78.54
132.732
201.062
314.159
490.874
804.248

<R R RIRIK
KKK KK K"
<R R KIKIK
K KKKEK Q
<R R KIKIK
< K K KIIBs

v oK

In left hand Filter pane, tick Column, Wall, Beam & Slab to hide diameters of other members

X cancel

y

» Tick the diameters of bars to be used in the design of those members as shown above. Generic is
for all other elements, at least 1 rebar must be ticked.

» Click OK to close Rebar Table > Click OK to close Rebar dialog > OK to close Materials dialog.

Load Combinations

We have already generated the cases and load combinations previously, as shown below.

No | Combination LLRed| RfC | Steel G Q Qpl1 Qp12 Qp21 Qp22 Qp31 Qp32 Qp4l Qp42 NGx NQx NGy NQy
1 64Q v v d 1.35 1.50 0 0 0 0 0 0 0 0 0 0 0 0
2 G+Qp1 v v 4 135 0 1.50 0 0 0 0 0 0 a 0 1] 0 0
3| G+Qp2 Cd 4 4 135 0 0 0 150 0 0 0 0 1] 0 0 0 0
4 G+Qp3 v v 4 135 0 0 0 0 0 150 0 0 0 0 0 0 0
5 G+Qp4 v v v 135 0 0 0 0 0 ] 0 1.50 0 0 0 0 0
6 GHQ+HNX o v O 135 150 0 0 0 0 0 0 0 1] 100 1.00 0 0
7| GHIx+Q (v v v 1.35 1.05 (1] 0 0 0 0 0 0 a 1.00 1.00 0 0
8 G+Q-Nx L v ' 135 1.50 0 0 0 0 0 0 0 1] -1.00 -1.00 0 0
9 GNx+Q 4 v 4 135 1.05 0 0 0 0 0 0 0 0 -1.00 -1.00 0 0
10 G+Q+Ny v v v 1.35 1.50 0 0 0 0 0 0 0 a 0 a 1.00 1.00
11 GHy+Q v v v 135 1.05 [} 0 0 0 0 0 0 1] 0 1] 1.00 1.00
12 GHQNy d d d 135 1.50 0 0 0 0 0 0 0 1] 0 1] -1.00 -1.00
13| G-Ny+Q v v v 1.35 1.05 0 0 0 0 0 0 0 0 0 0 -1.00 -1.00
ProtaStructure” ProtaSteel  ProtaDetails’ ProtaBIM’
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» Review & click OK to close the dialog.

Wind and Storey Loads

Allow user to review & input lateral loads such as notional horizontal & wind loads. We will skip this
for now.

Wind load cases and combinations must be generated first. For more guidance, kindly refer to
Prota Help Center : Wind and Storey Loads

Building Analysis Model Options

» Go to the Model Options > Model - Material & Section Effective Stiffness Factors and review the
stiffness factors as shown below.

Building Analysis

Pre-Analysis Model Options Analysis Post-Analysis Model Export Reports

Model ShearWall Model Slab Model Settings

I Material and Section Effective Stiffness Factors I Default Settings

Effective Material and Section Stiffness Factors

E:fs;jﬁ: Axial Area 5?;?:22 Shear Area ZEE?:::

Shearwalls (Shell) 1.00 0,50 In Plane 0.50 0,50 1.00
Out of Plane 0.25 1.00

Shearwalls (Frame) 1.00 0.50 Major 0.50 0.50 1.00
Minar 0.50 0.50

Basement Walls 1.00 0.80 In Plane 0.30 0.50 100
CQut of Plane 0.50 1.00

Slabs 1.00 0.25 In Plane 0.25 0.25 1.00
Qut of Plane 0.25 1.00

Columns 1.00 1.00 0.70 1.00 1.00

Beams 1.00 1.00 0.35 1.00 0.10

Coupling Beams 1.00 1.00 0.15 1.00 0,10

‘fou can modify the elasticity modulus, section areas, moment of inertias and torsional constants of the member groups to be used in the
analysis model. For example, you can enter 0.05 to reduce the moment of inertia values by 95% to reduce the lateral stiffmesses of the
columns.

Note: In order to apply these factors, building analysis must be repeated. These factors will be applicable only for load cases for which
cracked section properties are used.

The stiffnesses table will only be applied for load cases with Used Cracked Sections checked in the
respective Load Case Editor, except for seismic load cases where cracked sections are always
assumed.

All factors can be modified, except those that are greyed out, which must be auto-calculated.
Building analysis must be repeated each time the effective stiffness factors are changed.

To prevent large torsional forces in primary beams due to secondary beams, the global Torsional
Stiffness Factor is by default set to 0.10 (10%) in the Stiffnesses settings.

Stiffnesses of individual members can be changed by selecting a member = Right-click 2 Edit
Section/Material = Properties tab.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Running Analysis

» Go to the Analysis tab

Page - 52

Before running the analysis, it’s always recommended to check the model’s validity.

» Click Building Model Check & pick All Storeys & click Start

» C(lick Close to exit the check

0§, Building Model Check - a X
The building model check will pick up the most obvious
/| Overlapping Slabs Check | All Storeys
. Overiepping Cobanns Check modelling errors as indicated.
/| Overlapping Slabs with Beams and Walls Check Delete Orphan Corewall Panels
/' Columns Inside Slab Panels Check
“°‘;Z"“°‘f“E““””““‘“‘"“Si":* The warnings / errors are mostly self-explanatory. The
' Validity of Axis Intersections Che:
7 prosty of s Itersectons heck exact member(s) affected will be stated.
/| Overlapping Columns Spanning More Than One Storey Check
v Columns and Walls with Zero Length Check
¥/ Repeating Nenber Labeks Check You should review any warnings / errors and correct the
model before proceeding to perform analysis.
Check Overlaping Beams with Beams and Walls: ~
...Operation Completed.... Number of Errors= 0
Check zero e Lengih Beas: Click “Load Log to Editor” to open the list of
o Operen Competed. Huber cffrers=0 warnings/errors in a separate screen in Notepad for
Check Repeating Labels:
...Operation Completed.... Number of Errors= 0 ease Of refe rence
Building Mode! Check Completed... Number of Errors= 0 .
Load Log to Editor l v Start ¥ Close

The building analysis can now be performed.

Buiding Analysis

Pre-Analysic | Model Options | Analysis | Post-Analyss | Reports

Building Analysisand Design

=% Building Model Check X | | Building Analysis
Analysis Type: Static Analysis

Analysis Date: - Invalid —

Perform Eigenvalue Analysis (i)

Display Analytical Model Before Analysis

| Refresh the Connectivity Information of All Members:

Save Foundation Column/Wall Results for Multi-block Combined Foundation Design

Axial Load Comparison Report

Codes: 3
Eurocode 2 (S6), Eurocode 3 (5G), Eurocode 1(SG) o
Help F1

» Click Building Analysis

Eigenvalues analysis can be done to obtain the natural
frequencies and mode shapes of the structure.

The Batch Design Options dialog will appear. It allows you
to perform the design of column/wall and beams
automatically after the analysis. We suggest that this
should only be done if you are confident that the analysis
result is correct.

» Check Column/Wall Reinforcement Design
» Check Beam Reinforcement Design
> Pick Building Analysis to analyze & design the model

x The analysis will also check for instability and large

Close

deformations and there will warning messages if any are

The Analysis Summary Report will appear at the end of the analysis, summarizing the essential results.

ProtaStructure’
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Axial Load Comparison Report

An important check on the validity of the analysis is the Axial Load Comparison Report. This report
sums all the dead and live load applied at each storey and displays the axial forces in the columns and
shear walls. These values need to agree within a tolerance limit of 5%. If they do not, the reason for
the discrepancy should be investigated.

> Select Axial Load Comparison Report (in the Analysis tab)

Axial Load Comparison Report

TOTAL LOADS (Based On Slabs Loads):

G - Dead Loads:
Storey Column Wall Baam Slab| Ribbed Slab Total
& (+12.00m) - < - 251 X143 117877 0.00 1859.33
3 (+2.00m)] < 233 74112 1035.95 0.00 216614
2 (+6.00m] - 2331 74112 1035.9% 000 2166.14
1 (+3.00m) <] 20531 74112 103595 0.00 2166.14
Total 8357.76

Q - Live Loads:
Storey Column wal Baam Slab| Ribbed Slab Total
& (+12.00m) (.00 0.00 000 15547 0.00 15547
3 (+3.00m)] 0o 0.00 000 54686 0.00 54555
2 (+8.00m] Q00 0.00 000 54686 0.00 54555
1 {+3.00mj) Q.00 0.00 000 686 0.00 S48 5
Total 1706.05

TOTAL LOADS (Decomposed to Beams):

G - Dead Loads:
Storay Column Wall Baam Slab| Ribbed Slab Total
4 (+12.00m| =B ] 50953 1267 13 000 0.00 187042
3 (+9.00m) BT &)242 1670.96 0.00 0.00 216703
2 (+6.00m] - 4)242 1670.9 0.00 0.00 216703
1 (+3.00m) 875 40243 1670.96 0.00 0.00 267.03
Total 8371.50

Q - Live Loads:
Storay Column Wall Baam Slab| Ribbed Slab Total
4 (+12.00m| a0 2813 12734 000 0.00 15547
3 (+9.00m) aoa %5 23081 0.00 0.00 54555
2 (+6.00m] Q.00 %25 23081 0.00 0.00 S4m
1 (+3.00m) Q.00 5.25 230561 0.00 0.00 54085
Total 179805

BUILDING ANALYSIS COLUMN AND WALL AXIAL LOADS:

Storey G DetaG Q Delta Q
2 (+12.00m 180 &2 & 15547 15547
3 (+2.00m)] 3975 31 2104.50 233 5686
2 (+6.00m] 608020 2104 89 124913 RE8E
1 (+3.00m] 8185 08 2104 89 1796 .05 H586
Tota 8185 00 1796.05

Total Base Reactions: G=HB8300N Q= 1T9603EN

Table 1: TOTAL LOADS (Based on Slab) is the sum of dead and live loads of all members with the slab
load not yet decomposed or calculated on the beam. You can take this as the input weight of the
structure.

Table 2: TOTAL LOADS (Decomposition to Beams) considers the decomposition of the slab load onto
the beams based on either yield-line or FE Decomposition. The beam load now includes the slab loads
(and hence zero values are shown under the slab column).

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Table 3: BUILDING ANALYSIS COLUMNS AND WALL AXIAL LOADS sums up the actual column and wall

axial loads after building analysis.

Firstly, check Table 1. Total values are similar to Table 2. This ensures that beams accurately capture

all slab loads, i.e., no lost slab loads.

Then verify Table 2 total values are similar to Table 3. This ensures that all the super-structure weight
is entirely captured by the columns and walls down to the foundation.

Analytical Model

The Analytical Model enables you to review the results of the analysis graphically. It is essential to
check & verify the analytical model to ensure the model the correctly set up & results are reasonable.

» Go to the Post-Analysis tab of the Building Analysis dialog

» Click Display Analytical Model

A new Analytical Model tab set will appear with the Analytical Model view.

0 H -

Analytical Model

T Views
o Storey: 4 (Plan)
o, Storey: 4 (30)

P Reports
B3 Detal Previews

REESESENESE

-----

KRR KRR R R RIRIR

Displscement [Resultant] - (G) - Max:0.024, Min:5.92126-05m

The analytical wireframe is shown in blue. Load cases and combinations can be selected

side pane.

, (R R R R R R R
—

T
=/

ribbon tabs
Det: ~
Load Combinations
ﬂ»(; Load Cases
Q
-
Q12
Q21
o
Qp31
Q32
o
Qa2
- | NGx
o
g Load e
Combinations [ | eicmbesens

Il | se: mm , Ack: kv-m , Disp:m

Y2

on the right-

2: 12000mm [

If too much information is displayed, the screen can appear cluttered. However, you can create a

more meaningful display view by using the various filter buttons and the view settings.

>

In the General tab, click on the Filters command (if it’s not activated)

The filter options will appear on the left-hand side of the view. There are options to filter the
display by Storeys, Axes, and Member Type.

.:_. n <@ @ ZoomIn
= - |
. Q Foom Dut
View

Settings  Plan

&P Orthogonal

Appearance

ProtaStructure’

ProtaSteel’

E Save Picture
@ Copy Picture

® [ <

e e ‘B

Find Filter = Connectivity Linear Pushover Time History
Issues
Tools Analysis Result Type
ProtaDetails’ ProtaBIM’
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The Find command allows you to find a particular Node, Frame, or Shell number.
Connectivity Issues lists all the frames with unsupported nodes and highlights them when
selected.

» Click the Members tab

This is where you can show node labels, rigid diaphragms, element labels, and beam loads.

° N :’ Loads " / e V Frame Mo ‘,’ Rigid Members ¢ Local Axes 35 M shelle A Thidkness
SN L4 * Supports = AT Sections ‘_," Hinges ‘z’ Direction &' m ‘5_ Shrink M Materials ia
Nodes Labels Diaphragms Frames Labels . Frame Frame Load Shells Show Labels for
i Springs 50 Materials & Shrink Loads Labels A, Surfaces N Pressures | Selected Members Only

Nodes Frame Members Shell Members

» Click Frame Loads & Frame Load Labels icons to show loads calculated or decomposed on the
beams (& then turn it off).

This may include all the slab loads, brick wall loads, beam self-weight & other manual input loads.

» Click Diaphragms =2 Select All will show the rigid diaphragm formed by the slabs (& then turn it
off).

The grey lines join nodes constrained by the diaphragm to the center of the diaphragm mass.

> Click on the Results tab

A i 7
FCP B Animation «:e Auto Scale bg [ R L J\ shel Members N T il | =
‘P Bidirectional Animation [ FY /" Frame Members = Vi oM # =
Displacements i Diagrams Properties
pun Cubic Curve I_z' k. @ MNodes V3 M3 i
Displacements Diagrams Details

» Click Displacement =2 The red lines show the structure’s displacement (deflection).
By default, Auto Scale is activated. You can deactivate this and then type in your Scale.

Displacement Unit can be changed in the Settings Center > Units and Format

» Click on the various directional displacement values by selecting x, y, z & R (Resultant). Rx, Ry, Rz is
the rotation of joints in radians.

The Maximum and Minimum displacement is shown at the bottom of the screen.

» Click on this legend = an arrow will appear to pinpoint the node of maximum displacement.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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% B=0.000382  B=0700454 80001055
\\ B= 0498 \ B=0.001175
B=0.001319

B=0.001886

=0.002946
0.004363
.005883
BAOOT224
= 3

Deflections shown
B=0.00 in red lines

B=0.0071
B=0.005773

B=0.004236
B=0.002819

Click on this legend to
locate max displacement

G C-u

Displacemel]l [Resultant] - (G) - Max:8.441862, Min:0.235853 mm

» Click Animation to visualize the deformation of the structure.
» Switch off the Displacements display and click on the Diagrams button.
» Click on the Axial force N icon to display the Axial Force diagram (for G Load Case).

1_Model Analytical Model
I= BIM Display Views Help General Members Results Contours Solid Model
N T igdlabels |l Columns  Rigid Link
; " 2 pro  Auto Scale ji ShearWalls
Diagrams =
vy Mg Scale 2.5 (7 Beams
Diagrams

3 - Building Analysis Model X

Diagrams Legend

N - Axial forces

V2 — Major shear force of beams
and walls. Shear of column along
dir 1

V3 — Minor shear force of beams
and walls. Shear of column along dir
2

M2 — Minor moment of beams and
walls. Moment of column along dir
1

M3 — Major moment of beams and

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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» Experiment with the various effects of the diagrams.

You can change the diagram scale by de-activating Auto Scale & typing the desired Scale.
You on/off the diagrams on Column, Shear walls, Beams & Rigid link by clicking on the respective

> Click Properties icon reme & select a frame member will show the detailed member properties,
including material, section properties & summary of analysis forces at both members ends.

Frame: 216 Properties X
Frame No 216
Structural Member RBS8 (Beam)
Nodes -
Rigid Zones :
Restraints v
Material Properties v
Section Properties -
» I-Section
» J-Section
Temperature Difference v
Analysis Results () -
4 I€nd

N - Axial Force 0.00 kN
V2 - Shear Force 2 -25.97kN
V3 - Shear Force 3 0.00 kN
T - Torsional Moment 0.00 kN.m
M22 - Bending Moment 0.00 kN.m
M33 - Bending Moment. -33.41kN.m
4 )End
N - Axial Force 0.00 kN

Contours tab will show contour results for shell elements which will only be visible if finite element
shell walls is assumed, or floor slabs are selected to be meshed in Building Analysis.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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» Go to the Solid Model tab.

This allows the various effects such as Axial Load & effects to be color-coded on the physical
model.

Review Analysis Design Drawings & Reports BIM Display Wigws Help General Members Results Contours Solid Madel

N T E I_z' / Frames
v2 Mz Lx A, shels

vi Mz L
Solid Model
kel

3 - Building Analysis Model X

N
(kN)

-1472.16
-1349.48
-1226.80
-1104.12
-981.44
-858.76
-736.08
-613.40
-490.72
-368.04
-245.36
-122.68
0.00

HIRE00C00CEN

N

%

» Close the Analytical Model view by clicking on the “x” sign next to the view name.
» Alternatively, you can click to switch to plan view and exit the Analytical Model
interface.

You must interrogate the Analytical Model and check its validity as that is the actual analytical model
from which the design forces will be based.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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Column & Wall Design

» Navigate to the Column Section Design under the Design tab

Since we have selected to run column reinforcement design as part of Building Analysis, all the
columns and walls are already designed as indicated by a green tick.

=B v @ - Column Reinforcement Design - Project: Q5G1 - 0 x
IE- Design Reports ﬂ
= e
= =1 o B, V & [ s
Interactive Column Design Steel Settings and  Filter Delete User  Copy Bars é F
Design (BatchMode) Standardisation Parameters Defined Loads
Design Edit
e
Columns Storey (:rln) [:5‘) g‘:;;lg; Ut;\ll;zt;on Print Qty g;i??:ﬂd) Steel Bars Links
»| 6c1 1 500 250 v 0.42 NV E o 0.64 4XIH13 + 2X1H13 H10-250 ~
21 2 500 250 v 0.61 U4 0 0.64 4x1H13 + 2x1H13 H10-250
3C1 3 500 250 v 0.66 v 0 0.64 4x1H13 + 2x1H13 H10-250
RC1 4 500 250 v 0.73 v 0 0.64 4x1H13 + 2x1H13 H10-250
GC2 1 500 250 v 0.47 v 0 0.64 A 1H13 + 2x1H13 H10-250
2C2 2 500 250 v 0.37 v 0 0.64 4x1H13 + 2x1H13 H10-250
3C2 3 500 250 v 0.33 v 0 0.64 4x1H13 + 2x1H13 H10-250
RC2 4 500 250 v 0.41 v 0 0.64 4x1H13 + 2x1H13 H10-250 o

If they are not designed, you can choose Column Design (Batch Mode) > Reselect All Bars to design all
columns at one go.

» Go to the Reports tab = Choose Design Report @

A tick in the Print column marks the columns included in the report. Columns can be added or
removed from the report by checking or unchecking the Print checkbox. Furthermore, icons Mark All
Columns and Remove Print Marks can be applied to all columns.

Column Design Results
ReportOptions

Indude All Load Combinations in the Report
Include Interaction Diagram in the Report

Display All Combinations in the Interaction Diagram

I | include Column/Wall Sections in the Report I

Column Design Report Title:

Column and Wall Design Results Report can be prepared using this dialog.

The report will contain the members as filtered and sorted in the Column/Wall Design Table

L4 X

oK Cancel

» Check “Include Column/Wall Sections in the Report” to draw the column section detail.
You can also give the report a title.
» Pick OK to generate the report

All reports can be exported in PDF, MS Word, image, or webpage (HTML) format.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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@ aj e

S & & [110.00%
= 3 O FitPage 2, [110.00% = o To Image -
- B Ft width @, ZoomIn
Print 100% - POF To Office L] W .
m Y [0 Mutiple Pages €, Zoom Out 1 vertcal Ruder o= o Toweb
Zoom Show Export
Notffications a | B E

Headngs

I:L‘olumn Reinforcement Design
GC1 (A-1) (500/250)
Materials: C30/37/ Grade 500 (Type 2) (Links: Grade 500 (Type 2))

Section

| W S

Critical Loading: 1 - (G+Q)

Min___Design

N 67404 674,04 kN
My 2068 1348 2351 kNm
Mz nn 1348 3478 kNm
Ny 303153
Concrete Cover = 35 mm
= Neuiral Ads. 174 mm / 11.45¢
Shear
Veaz = 15.18/10.34 N Slender Column.
Ve = 0.13/0.13 Nimm? ALim, =
Viee = 1.04/1.15 Nimm? AdLimg =
- 5707570 Nimm!  |Massnz=
= Links = H10-250

253z205
16<08 v
A75/000 WNm

Rebars
As (Req)
As (Sup)

6H13

%5020
%064

250 mm#
796 mmé

CcMnF::mfur-:cm:mEcslml rage: [l 11 ‘ i MoEmors () NoWamnings () Messages: 0

» Exit & this report will automatically be saved & made available for compilation in Report Manager

The Interactive Column Design allows you to examine & alter individual column designs in more detail.

» Double click on GC1 in the list of columns in the Column Design screen.

3 | Unks | ShearDesgn | Slendemess | Setongs

Required
Area (mm2

Qty Area Rato Diameter

Loading: N
Requrred

Select Marked Combinations as User Defined Spphed

C30/37 | Grade 500 (Type 2)

Select/Unselect Al

Section Dimension shows the
parameters of the column such as size,

clear height & concrete cover

Steel Bars shows the number and
layout of the rebar. These can be
changed.

Load Combination table list down all
the load combination. The most critical
(governing) is highlighted in red.

Required & Supplied As are calculated
from the critical load combination.

Slenderness tab shows the bracing

assumption, calculated effective

If there are changes in the assumption of this column, you can

re-perform the reinforcement design.

click the Interactive Design button to

You can change the dimensions (b1,b2) above & click Update. This is handy if a column fails due to
insufficient size & you want to try out if a bigger size works. However, due to the change in column
size, the weight & stiffness of the model will change. Hence, you should re-run the analysis and re-

check the column design to ensure it is sufficient finall

y.

» Click Column Analysis to inspect the Interaction Diagrams (capacity curves).
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The Interaction Diagrams (N-M) show the possible combination of axial force and moment that cause
failure to a given column dimension and rebars. This “capacity curve” indicates the maximum axial
capacity of a reinforced column is dependent on the co-incident or applied moment (vice versa). The
axial capacity of the column decreases as the applied moment increases until the ‘Balance point’, the
max moment capacity. After this point, moment capacity decreases with decreasing applied axial load.

1% Interaction Diagrams - Column

GC1 (Storey: 1)

INTERACTION DIAGRAM (N-M) - GCIN= 542.61 kN M22= 19.4 / M33= 28.5 kN.m

N (k)

(500/ 2

50 mm) 8H13

> Select Interaction Diagram (N-M)

For rectangular columns, there will be 2
capacity curves in direction 1 and direction 2
respectively.

The governing design will be the direction with
load combinations closer to the curve; for this
column in will be along dir-2, the shorter
dimension & hence weaker capacity.

> Select Dir-2 (N-M22)

B

| Design Maments

a L]

| All Combinations Help T

Close

To verify that this column passes with the
rebar selected, all the design combination
points must be within the curve, especially if
you have manually changed the rebars in
Rebar Table.

4

The Interaction Diagrams (M22-33) plots the component directional moment capacity of the column
at a given applied axial load.

» Close the Interaction Diagram and go to the Slenderness tab

The Slenderness tab shows the bracing conditions of the column/wall, effective length factors &
additional moment (M-add) due to slenderness.

Steel Bars Links Shear Design Settings

Bracing

w*| Dir-2: Braced

/| Dir-3: Braced

Effective Length Factors

B-2: 0.729

B-3:

0.669

Bracing

Dir-2: Braced

Dir-3: Braced

Effective Length Factors

B-2: 1792

B-3:

1.442

Edited

Slenderness
A2fAimit2

A3fAimit3 0.3

Edited

>

DESIGN REPORT
CRITICAL COMBIMATION: #1 (G+Q)

Edited

Added Moment-22 = @.8@ kN.m

Added Moment-33 = 0.60 kN.m

N-Design = 524.46 kN

M22-Design = 19.55 kN.m

M33-Design = 28.74 kN.m
Slenderness

A2fAHlimit2 1.229

A3/A-imit3

1.978

Edited

——>

DESIGN REPORT
CRITICAL COMBINATION: #13 (G+Q-Ny)

Added Moment-22 =  38.12 kN.m|
Added Moment-33 =  10.36 kN.m|
N-Design = 525.35 kN

M22-Design = 50.89 kN.m
M33-Design = 31.51 kN.m

For this column, it is braced in both directions, the
calculated effective lengths B are less than 1 & hence
M-add is zero or minimal.

You can change the bracing condition manually.

» Untick both Dir-1-Braced & Dir-2 Braced

» Click Interactive Design to refresh the design

>
>
Notice that the unbraced condition of the column now
results in effective lengths > 1. As a result the
additional slenderness moment, ‘Added Moment’ is
calculated and auto-added to the base design moment
to become the final design moment.

Click Design Report for detail report
Go back to Slenderness tab to review

If you want to manually save either the Bracing or B
factors, ensure to tick “Edited”. This means the design
module will not auto-calculate these values anymore.

» Click Diagrams to view the shear force, bending moment, or deflection diagrams.

» Click Elevation Drawings to view the reinforcement of the column in elevation.

ProtaS
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Manually Specifying Column Design Forces (for info)

The column design forces are automatically linked and updated to the latest analysis run. You can
over-write the column design forces manually.

To manually enter column design forces :
1. Select the first row of column design forces
To select more rows, hold down CTRL key

alm 2. Pick Select Marked Combination as User Defined

ot % 3. Click on figures under “N” axial load & enter
. figures for top and bottom, e.g. 1000,1000

e umew 4. Pick Select / Unselect All to select all rows

5. Click Interactive Design to refresh the design

L e o 6. Untick User Defined Loads to auto-link back to
analysis forces.

Manually Change Column Reinforcement (for info)

The column design module will automatically design the column to pass status. However, there are
situations where you might want to specify the reinforcement manually & check if the column passes.

To manually fix the layout & number of rebars & let column design auto-select rebar size :

Column Design

B L% A0

Interactive Column [, ~.ms Save& Reset

g #l v x

Parameters] Image Elevation OK Cancel 1. /nput ”2”f0f 1'Int Uﬂdef Qty CO/umn

Design Analysis Report Report Bars Max/Min  Drawing
4 ) i Notice diagram now shows 2 nos. internal
Fr—— swdtme | e | Shewveson | Seniemess || NOFiZONtal bars on both sides
e e st S [y | weonew] e 2. Pick Parameters
3 s 1 . **| 3. Pick Fixed Bar Layout Method 20K

2-4nt 0 1 0

This option ensures that the number of bars

Material

Concrete: C30/37 - Fck=30,00 Njmm2 P WI” not Change dUring rE‘deSign
@ |[ v |[ x | |Requred b 4. Click Interactive Design to re-design
] o (= Supplied As= 1062mm2 (%0.85) = As,min . .
The column will be re-designed to 8 number
C30/37 / Grade 500 (Type 2) N M1l M2 L . . K
No @) Nm)| G of bars as specified. If this reinforcement is
— soton 67740 032 1298 insufficient, the program will auto-increase
2 -Tof 665.87 20.69 31.99 .
Sotton| omss 031 38 the bar size, say from H13 to H16.
3 -Top 618.71 20.53 26.32

You can also manually change both the number of bars and rebar sizes (i.e., both Qty & Diameter). Do
not click on Interactive Design, which will change the rebar sizes. You must then manually check the
following to ensure the column passes :

» Check As Supplied is more than As required and Min Steel %

» Click Column Analysis = Check all design points are within the Interaction Diagrams N-M11 & N-
mM22

»> Click Cancel to exit the Interactive Column Design dialog and Close the window.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Beam Design

» Go to Design tab = pick Storey Beams U

Since we have selected beam reinforcement design as part of Building Analysis, all the beams are
already designed as indicated by green ticks.

Hav g - Storey Beam Section Design and Detailing - Pro; - 0O x
Design | Grouping 2
= f—— == = &= =t = == == Mark All Design Axes
= A A = = Y ED (2 Paste Bars s | T =2 % *s % Mark Group r:asrer Aoxes Only
Interactive | Beam Design | Diagram Optimize  Settingsand  Fiter CopyBars ([} PasteBarsto Al  Summary Design Flange Barlist Beam Capadty Utiization
Design || (Batch Mode) Rebar Layers Parameters  Axes Table  Report Shear Check Reports Ratio Table @ Remove Print Marks
Design Edit Reports ~
Group is Storey Part Beam Quantity Rebar Pattern Design U. Ratio Print Beams
A 1 1 5 1 Standard Pattern 2 v 0.88 v GB1-GB2-GB3 - GB18 - GB19 A
B 1 3 1 Standard Pattern 2 v 0.93 v GB4-GW1 -GBS
c 1 1 3 1 Standard Pattern 2 v 0.81 v GB6 - GW2 - GB7
@1 1 1 1 1 Standard Pattern 2 v 0.98 v GB8
D 1 1 2 1 Standard Pattern 2 v 0.97 v GBS -GB10 v

If they are not designed, you can choose Beam Design (Batch Mode) to design all beams at one go.

A tick in the Print column marks the beams included in the report. Beams can be added or removed
from the report by checking or unchecking the Print checkbox.

» Choose Remove Print Marks to exclude all beams in the report

» Check/tick the checkbox under Print for the first-row beam axis A only

HMav g - Storey Beam Section Design and Detaiing - Project: QSG_r6_113 - 0
Design  Grouping a
—, — = — L =,
= L = 7 @ Ar == — = = (3 Mark All Design Axes
= ——= = aste Bars | =2 | ':|: f': A
= =] kvA == L = == Yo B Mark Group Magter Axes Only
Interactive Beam Design  Diagram Optimize Settingsand  Filter  Copy Bars (4 PasteBarsto Al Summary Design Flange BarList Beam Capadty Utiization
Design  (Batch Mode) Rebar Layers Parameters  Axes Table  Report Shear Check Reports Ratio Table | @ Remove Print Marks
Design Edit Reports
Group Axis Storey Part Beam Quantity Rebar Pattern Design U. Ratio Print Beams
A 1 1 5 1 Standard Pattern 2 v 0.88 GB1-GB2 - GB3 - GB18 - GB19
B 1 1 3 1 Standard Pattern 2 v 0.93 GB4- GW1 - GBS

» Choose Design Report

BEAM DESIGN RESULTS

The Beam Design Report is in rich text format.

Report Options

7 provt Beam Loads Print Beam Loads — List all the loads on the
] Print Shear Force Diagrams beams in table format. This will significantly
/| Print Moment Diagrams increase the size of the report.

| Split Tables (Faster, more pages)

¥ Print Rebar and Axis Image Print Shear / Moment Diagrams - Print the

envelope shear / moment diagrams in pictures.

Beam Design Results Report can be prepared using this dialog.

Report will indude only the filtered beam axes in the Beam Design Table, Select\Deselect All

Print Rebar and Axis Image — Prints
reinforcement design as shown in interactive
Reinforcement Data interface. This will

Cancel significantly increase the size of the report.

» Uncheck Print Beam Loads.
» Uncheck Print Rebar and Axis Image

» Pick OK to generate the report

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Prota Asia (21838)

Beam Reinforcement Design

Axis: A  Storey: 1

Diagrams

Beam Reinforcement Design

Materials: C30/37 / Grade 500 (Type 2) (Links: Grade 500 (Type 2)) Concrete Cover: 35 mm

Bending
GB1 L= 5000mm GB2 L= 5000mm GB3 L= 7888mm

| B x H (mm) 250 % 500 250 x 500 250 x 500

Flange Bi x Hr

(Left) — — —

(Right)

Top Edge
M (kN ) 613 0o 776 627 80 1035 047 199 2030
d (mm) 449 449 449 449 449 449 449 449 449
KK 0.24 0.00 0.31 0.25 0.03 041 0.81 0.08 0.80

> Exit & this report will automatically be saved & made available for compilation in Report Manager

The Interactive Beam Design allows you to examine individual beam design in more detail

» Double click on any of the beam axis in the list of beams in the Beam Design dialog

ﬁ N Reinforcement Data - Axis
Beams Rebars
[N, = 4 Previous Span Y Copy Bars =
- B - Il (=
B Mext Span [, Paste Bars
Select  Diagrams  Detail Display Not Scaled = Design OK
Bars Drawings Moment Values Span | 3500 ¢ (A PasteBarstoAl  Report
Copy/Paste Repo E
Standard Pattern 2 e 2
3.00
1 Lee1 hd ' | eB2
- 375.46 13.00 479.51 408.44
Ri ed As 2]
equin g, IC 18.37 271.41 0.00 G(‘ZZ 0.00
' 250x500 '
' '
500 4500 , 500 |
1 t t
Extra As{mm2) | I
As-min (Top) 162.50 162.50 162.50 162.50
As-min (Bot) 162.50 162.50 162.50 162.50
s-Bar-CL (Top) <68 > < 68> < 68> <68 >
s-Bar-CL (Bot) <74 > <74 > <74 > <77>
Deflection Check L/d = 9.76 < 48.55
X-5up. Links [] 0 0
Links 1R8-200 1R8-200 1R8-200 1R8-200
Top Bar 3T16 . ) _
Support Top Bar 1 3T16
Support Top Bar 2
Bottom Bar 1 3712
Battom Bar 2

Support Bottom Bar

Web Bar

Reinforcement Data window shows the
details of the beam design.

Required As is shown in blue as is based on
design envelope of all load combination.

Extra As shows the additional or surplus
area of steel based on selected steel.

s-Bar-CL (Top)/(Bot) shows the spacing of
the rebars at the outmost layer.

Deflection Check shows the actual vs
span/effective  depth. The
modification factor is automatically applied.

allowable

Rebars designed are shown in the various
rows including shear links. These can be
manually changed if desired.

Any figures in red indicate a failure to meet the design criteria and should be investigated.

» Click on the Diagrams button to see the loading and design forces.

ProtaStructure’
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\Z2 Beam Design Diagrams - [m] X

Beam Axis X 36,186
I : Label Label GB4
/| Display Detalled Values Loads (kN/m} 775 Z 3 Frr:me D il Framel\jﬂi‘
. - - ation
7 opte tators Local Axis2 Ditance 4417 4451
Diagram N~ Disolav Detailed H 10.111
L1 (A2 L3 isplay Detaile 47
N vz L, - Loads, Diagrams 54 s Values
T ovMs LMz & Deflections :
782 &3 m 29.024
Deflection Display Type V2 (kN) /m,r
— | [— E‘ W’ W
-38.624 29846
Load Cases & Combinations -63.908
5 " -52.391 -50 608
A -39.515 -37.834 salsso
NGx -
e -14.256
NGy
el M33 (KN.m) —ry
W 6.716
b
G+Q F 41.563 40731
G+Q"F1
G+QP1°F
Gamr Qe LOAdS _Cas_es &
Ge+Ge+Ser
Gese- S Combinations 0.1 7362 0.1
Ge+Qc+S5x- 52 (mm) e
Ge+Qc-5x-
Geso-5y- \/
Ge+Qc-Sy+
Go+Qc+Sy-
gcﬁ('slc-Sy- -1.0 0.9
IC+IX+
Ge-Sx+ Frame ID ST 55 =
Ge+Sx-
Ge-Sx- GBI15 GBS GB4
Ge+Sy+ L=5.00 L=5.00 L=5.00
o v
s~ NN Iﬁ Visualization 2
Show Magnified Seismic Design Results Tools B3 Report ® Exit

Loads, Diagrams & Deflections

2
0.0

Display Detailed Values :

e Checked: A tracing window will appear showing the exact values of the diagrams, e.g., shear &
moment, when the mouse cursor is placed at a particular location on the member.

2
0.0

Optimize Stations :
e Unchecked: The diagrams are displayed using the default maximum number of stations.

e Checked: The number of stations will be reduced & optimized to maintain similar accuracy.

2
0.0

Diagrams :

e |1/L2/L3: Check to show slab loads decomposed & user-defined loads on beams
e N = Axial force ; T=Torsion

e V2 =major shear ; M33 = major moment ; 62 = major deflection

e V3 =minor shear; M22 = minor moment ; 63 = minor deflection

2
0.0

Deflection Display Types :
Deflections are calculated along the member span for each load case and combination. Deflections
can be displayed in three different ways:

e Absolute: The absolute rotation and deflection values display the deflected shape.
e Normalized: The absolute shape is normalized to the value calculated at the first point.
e Relative: The deflected shape is normalized to both start and endpoints. This is particularly
useful in determining the deflection relative to both ends in serviceability checks.
Visualization Tools & Report

% Horizontal Scale W/ > Increase or decrease horizontal Scale of diagrams

< Default Display Scale E —> click to reset to the default scale

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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< Increase / decrease font size
«» Default Font Size Al -> Click to rest to default font size

% Report ®' -> Generate a report in tabular format with/without diagrams.

» Exit the diagrams & Close the beam design dialog

The same beam diagrams can be assessed by :
> Select a beam on plan view =2 Right-click = Analysis Results Diagram
The same diagrams are used for columns & walls :

» Select a column or wall on plan view =2 Right-click = Analysis Results Diagram

B
> Alternatively, access the Interactive Column Design = pick ‘Diagrams’ '~

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Slab Analysis & Design

For beam/slab models, slab reinforcement can be obtained by inserting slab strips in the X and Y
the tables in BS8110. This is
independent of the general building analysis and can be carried out before or after the building

directions. This process uses the moment coefficient method from

analysis.

To use the moment coefficient method, it is essential to set all the Slab Types correctly per the tables
licking on the slab icon in the

in BS8110. This can be done automatically in batch mode by right-c
structure tree and choosing Set Slab Types Automatically.

Page - 67

» From the Structure Tree, double click on storey St: 1 to return to the 1% Storey plan view.

» Right-click on Slab = Set Slab Types Automatically - Choose defaults options 2 OK

4 [€ Storeys

B, Messages - (] et
» © St: 0 ( +-0.00m) -
4 0 St1(+3.00m, Sim:2,3) Total Number of Slabs at the Storey= 8 ~
1 Count of total slab hole in storey=0
» || Columns
b ) ShearWalls Unspecified Slabs:
g 6S3
» (f Beams GS10 (Edge Count> 4)
» & ~ o
(Y Slab Table Specified Slabs:
i/ Ribbed Slabs | = GS4 (Type=7)
. . ) GS5 (Type=4)
&5 slab Strips L. Slab Analysis and Design 656 (Type—7)
% B GS7 (Type=7)
races =4 Slab DeflectionCrack Check G58 (Type=4)
= Trusses G59 (Type=7) .
i = Slab Reverse Deflection Table
L L Purlins
. . v oK
- Girts Set Slab Types Automatically
A .

Slabs that do not have 4 edges is beyond the scope of the moment
entirely up the user to set the appropriate slab type or use alternat
analyse & design these slabs.

» Click OK to close the Messages dialog.

» Go to the Modelling tab & click on the Slab Strip

The Slab Strip Properties will be displayed:

coefficient method. It will be
ive finite element method to

e Slab Strip Type: Analytical Strip is used for design based on the Code Method. FE Strip is used for
innovation based on Finite Element Analysis results. Manual strip is used to manually input rebars
without any analysis & design.

e The correct “At Start” and “At End” boundary conditions must be  Slab Strip
specified when drawing the strips. The three options are:

General FE
== Slab - The Strip starts or ends inside a slab. The bottom
X1 Dir: | X Y

steel for the slab in question is not designed, but the span of the
slab can be defined, and this value is used in determining the
support steel extension.

= Bob - The Strip starts or ends beyond an edge beam or wall.
The support steel at the edge is bent down into the beam/wall.

—

7

Cantilever - The Strip starts or ends beyond a cantilever
slab.

<>

No:

Type: | Analytical Strip |V
Boundry Conditions

o e
e

[T
—

—

At Start:

(=
—yY
=
=
y—
3

RS | | —
=

| =

At End:

ProtaStructure® ProtaSteel ProtaDetails’
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Set the Dir: to X

YV V V V V

Set Type to Analytical Strip
Set the At Start condition to Bob.

Set the No: to ‘1’ so that the strip label is X1

Set also the At End condition to Bob.

Page - 68

Slab Strip

General [ FE .

X1 Dir:@ Y

Pick the slab strip’s start point outside the floor plan, as shown below.

Type: | Analytical Strip | v

—Boundry Conditions

» Hold down on the CTRL key and then click the end of the strip to the

right of Axis 4

& e
— —— e —  —|

S |y —

At Start: == |: I:'_

e e | ]

AtEnd: == 1=]|l== .

» Draw another similar slab strip X2 to obtain the design for the slabs between Axis B-C/1-2

» Draw similar slab strip X3 to obtain the design for the slabs between Axis B-C/3-4

» Draw slab strip X4 to obtain the design for the slabs between Axis C-D/1-4

®

ProtaStructure’

ProtaSteel’

ProtaDetails’

ProtaBIM"



B PrroTa g 60

Now draw the vertical strips to design Y-direction rebar for the slabs. Skab Strip .

» Change the Dir to 'Y [ General
» Reset the No: to 1 again so that the strip label is Y1
» Keep Type as Analytical Strip No:

» Keep the At Start condition as Bob
Type: | Analytical Strip | v
» Also, keep the At End condition as Bob

Boundry Conditions
» Draw 4 nos. of the vertical strip through all of the slabs atstart: (2=

The final layout of strips & slab reinforcements should be as shown Atend: ==

below.

We can now re-check the strips as a batch and create a slab analysis & design report.

» Go to the Design tab - choose Slab Analysis and Design

B o< Slab Analysis and Design - X
Design
v Ji 5 kS =3 " “
= - = = v [E ) Paste Bars ﬁ (@ Mark All Siab Strips
Interactive  Slab Strip Design Check Slab = Settingsand  Filter  Copy Bars I3 Paste Bars to Al Design q Remove Print Marks
Design (Batch Mode) Thickness Parameters Report
Design Edit lad

Slab Strip Storey Type Analysis Results Sour... | Slabs U. Ratio Design Status Print Rebars
GS2 (h=200 mm) i 21H10-225 + 19H10-250

X1 1 Span Strip = GS3 (h=200 mm) 0.79 v v 21H10-225 + 19H10-250
GS1 (h=200 mm) 17H10-225 + 20H10-250 + 14H10-250

X2 1 Span Strip - GS4 (h=200 mm) 0.79 v v 21H10-225 + 19H10-250 + 19H10-250

X3 1 Span Strip - GSS5 (h=200 mm) 0.79 v v 21H10-225 + 19H10-250 + 19H10-250
GS6 (h=200 mm) 15H10-225 + 13H10-250

X4 1 Span Strip = GS7 (h=200 mm) 0.79 v v 21H10-225 + 19H10-250
GS8 (h=200 mm) 21H10-225 + 19H10-250 + 19H10-250
GS2 (h=200 mm) 21H10-225 + 16H10-300

Y1 1 Span Strip - GS4(h=200mm)  0.89 v v 21H10-225 + 16H10-300
GS6 (h=200 mm) 13H10-225 + 18H10-250 + 10H10-250

Y2 1 Span Strip - GS3 (h=200 mm) 0.89 v v 21H10-225 + 16H10-300 + 16H10-300

Y3 1 Span Strip S GS7 (h=200 mm) 0.89 v V] 21H10-225 + 16H10-300 + 16H10-300
GS1 (h=200 mm) 18H10-225 + 14H10-250

Y4 1 Span Strip - GS5 (h=200 mm) 0.89 v v 21H10-225 + 16H10-300
GS8 (h=200 mm) 21H10-225 + 16H10-300 + 16H10-300

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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The slab analysis & design dialog will appear with a summary of pass / fail status, utilization ratio &
reinforcement. The functions at the top menu bar are :

«» Interactive Design: Select a slab strip > Interactive Design will allow access to detail strip design

< Slab Strip Design (Batch Mode): Redesign or re-check the existing design of all strips at once

«» Check Slab Thickness: If applicable to the selected code, check the sufficiency of slab thickness.

«» Settings & Parameter: Opens up the slab design settings in the Settings Center

< Filter: Allows filter by a storey, slab thickness, and design status

« Copy Bars & Paste Bars: Allow copy & paste of bars of similar slabs marked with = symbol
«» Design Report: Prints out the design report

» Click Design Report

The Slab Reinforcement Design report will be displayed. Options are available to configure and then
print it. Any failure in the design will be highlighted in the Notifications pane at the left.

Siab Analysis and Design - 0O x
S0 .00% N\ S
= ’—‘-) 0 FitPage Q [100.00 Y| Horizontal Ruler @ @ [ TolImage -
= ED 1), Fitwidth @ zoomIn
Print  100% POF  ToOffice [ Toweb -
® [ Mutple Pages &, Zoom Out 1 vertial Ruler . g Toweb
Zoom Show Export
Notifications LI - ENTCE RN R KN KRR RNRE 6107 e iz ST s T 194 2 ()
Notifications ~ Headings 5
@ Gs2:Supplied Reinforcement is Suffient - Slab Analysis and Design
O Gs3:5upplied Reinforcement is Sufficent - = Defintions
© Gs1isupplied Reinforcement is Suffident - d Siab's Effectve Depth
h | Siab Total Depth
@ Gs4:supplied Reinforcement is Sufficient . ‘g max In_'lamum Load Combination
K] Wilth of the Slab Along the Stip Drrection
O Gss:supplied Reinforcement is Suffident - L Width of the Siab Pemendicular 1o the Strip Drection
@ Gss:Supplied Reinforcement is Sufficent fﬂ mxe‘ :;f:':f"“c =Wi(plh)
O Gs7:supplied Reinforcement s Sufficent - LD Roirforcment A

@ Gss:Supplied Reinforcement is Suffident -
- Slab Strip : X1 -- Storey : 1
© Gs2:supplied Reinforcement s Sufficent

O Gs4:5upplied Reinforcement is Sufficent S Materials : C30/37/Grade 500 (Type 2)
© Gs6:5upplied Reinforcement is Suffident - .
: dih qmax | | “[Support] Span | W AsLeft [ AsSpan [ ASRht | o | spanBars | Right
O c53:5upplied Reinforcement is Sufficent = sup | Mm) max L] C | Leit | Requied | Requred | Requred | o o | gy | Support
- Angle | Combination = M M Right Provided | Provided Provided Straight Straight Straight
@ Gs7:supplied Reinforcement is Sufficent B C) | GkNime) GNm) | G| GNm) | omd) | o) | () < < &
= o2
@ Gs1:supplied Reinforcement is Sufficent - 165200) 1287 | 5000 | 0.0450 [0030( 15 243 249 A9 | HIOB0 | e | HIG2S0
S fe]| o |rae-salam| B | ey | w1 | wo | oW | om | M0 T
@ Gss:supplied Reinforcement is Sufficent - L
- )
@ Gss:supplied Reinforcement is Suffident 5 5200|1287 | 5000 [ 00450 [oom0| 131 | 29 %9 23| OB | e | HIO20
g 0 [1356-150(4750| 131 | 99 | 115 | 34 19 M4 ™) o ™)
-4 GS1 -
- 65200 1287|4331 [ 001 foos1| 15 | 29 u9 29| IO | oo | HIOZ0
B 0 [13%6.150(&273) 80 | &1 | 09 e 19 314 ) S ]

Deflection Check

1701t e

Slab ud Udtsimm |5 Status v

iab Analysis and Design | rage: [l 4 ‘ A Y ———

» Review the report and then Exit

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’



S PRoTA

Page-71

Design Status

The design status can be displayed graphically in the plan or 3D window.

> Click on the 3D view to make it active

» Go to Review Tab - pick Design Status - OK

Analysis  Design  Drawings &Reports  BIM  Display

ews  Help
€ T, ey =
5 » = [H|H H s M 8
. ] 5 1 " U
v B i'?‘ : =1 Busst 1888/ o ] _ &
Fix the Purge  Refresh Connectivity Visual Design | Column Beam Sections Materials Beam Wal Slab Additional
xes Almost-Orthogonal Axes  Sections Information Interrogation | Status | sections Types Loads

Visual Interrogation

Storey: 1(30) X

Design Status

. Fail

D Warning

D Expired Analysis
B o«

D Not Designed
. Do not design

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Quantity Extraction Tables

The concrete and Formwork quantity reports can be produced.

» Go to the Drawings & Reports tab = Pick Quantity Extraction Tables
» Choose Concrete Quantity Extractions Table =2 click Calculate

As shown below, this produces a concrete quantity report with member type and storey breakdown.

» Click Report to produce a detailed report

Project Preferences

The Project Preferences dialog allows you to enter the details of the project model.

» Go to Building Setout tab > Click on Settings Center = Project Preferences = Header

Options

Licence: Prota Asia (21838)
» ‘ ProtaStructure Environment

Consultant
b ° ProtaDetails Environment

Calculated by:
— Controlled by:
4= Pll'oject Preferences Drawn by:
| Title Presented by:
Statistics Project
Notes Client Mame:
%0 Unit and Format Project Title:
’ Et: Label Project No:
|2) Codes Project Date:
3H Lateral Loading Project Address:
[¥] Lateral Drift & Bracing Revision No: 1

Title - Enter the Consultant and Project details to be displayed in the header of all the reports.

Statistics - Show graphical chart of essential model information such as the total number of members,
members types, grids & storeys. In addition, it shows the number and types of foundation, beam &
column end releases. A text file can be created.

Notes - Enter additional information on this model, such as revision changes, etc.

» Key in the various information in the Title tab as desired

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’

Quantity Extraction Tables X
Quantity Tables
Report Format
Storey Beam Column Slab Rib Slab Blocks Foundations
@) ProtaStructure Report
Foundation 0.00 5.71 0.00 0.00 0.00 0.00
1 10.76 15,56 32,69 0.00 0.00 0.00
Tables 2 10.76 15.56 32.69 0.00 0.00 0.00
/| Concrete Quantity Extr: 3 10.76 15.56 32.69 0.00 0.00 0.00
i ) s 4 10.76 15.56 37.20 0.00 0.00 0.00
Formwark ,
ormwork Quantity Table Total 43,03 67.9 135,27 0,00 0.00 0.00
——
9 Total Concrete: 246.25 m3 i < x
Calculate i . Report d Close
Help F1
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Report Manager

The Report Manager is the central report manager where all analysis and design reports can be
accessed and managed.

=
» Go to the Drawings & Reports tab = choose Report Manager =
= Report Manager (Ed ] x
. = X = *
Current Set: Ir ] ) New [3.. Add All Available @ - + Expand Al [!]'t' ] Load Logo
Defouit v [ Add Al 2% PROTA
View ™ pelete | New Report - Collapse Al | Use QR X Clear Logo
. [> Remove Al From File Code
Report Sets Reports Header Settings
== 4 Model Information
Default | == 1T 1 x 2 Notifications QLD & »
Pre-analysis Checks Quick_Start_Guide_Complete-...
Beam Loads Beam Loads Quick_Start_Guide_Complete-... || 4 Post-analysis Checks
) _ Warning: Dir 4... Effective Mass Ratio is less than
Slab Additional Dead Loads Quick_Start_Guide_Complete-... 0 90%. Number of effective modes should be increased
Beam Wall Loads Quidk_Start_Guide_Complete-... and analysis must be repeated.
Analysis Model Echo Report e e— o (B2) Irregularity Check is not performed. !
@ Overturning Check: Dir 1... Mp1 /Mal = 61850.3 /
Storey Displacements Column/Wall Design Reports 751.2 = 82.3408 =2 2.0 OK
» / sign Repol
. " Overturning Check: Dir 2.... Mp2 /Ma2 = 61055.5/
Axial Load Comparison Report » Beam Design Reports . AO7 S = R7 51 >70 NK
Report Sets Reports Repository
It e Notifications
Beam Quantity Report » Foundation Design Reports
» Quantity Take-off Reports
» Building Assessment Reports
» Other Structure Components

Reports Ready: 11/50

e Report Sets (left): This shows the constituent reports, which will be complied & combined into a
single final report.

e Reports Repository (middle): All the individual reports generated and available to be included as a
Report Set.

¢ Notifications (right): Important notes and warnings from the model’s analysis are shown for easy
reference.

You can expand or collapse the main folder by clicking on topic icons. To create a combined report :

| New
> Select New *~ " inthe Report Sets tab and give the new report set a name

» Select Add All Available Ce. reports in the Reports window to include only available and generated
reports in the report repository.

Alternatively, click and drag a report from the Reports Repository into the report Sets pane.

» Choose to insert Table of Contents =
tab.

and Summary Report i= using icons below the report Sets

» Select View & to generate and view the report set.

Other useful functions include loading of company logo : Load Logo !, inserting QR Code = &

inserting external .doc or .rtf files : New Report from File LE)

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Steel Model

We will now start a new steel model. This section will cover steel members, trusses modeling, analysis

& design. The below is the screenshot of the completed model, which can also be found in the default
Project Data folder.

)

_',,
Q‘/

) —-' A
A)

3

e

» Click New Project N and type the project name as shown using the *_’ character for spaces.

New Project

Project Code: |Quick_Start_Steel

(Available Characters: A-Z, a-z, 0-9, _, -)
Templates

Search....

Ireland (Eurocode) ~
Malaysia (BS8110)
Malaysia (EC2, EC8-DCH)
Malaysia (EC2, EC8-DCL)
Malaysia (EC2, EC8-DCM)
Malaysia (Eurocode)
Philippines (ACI318, NSCP2015)
Poland (Eurocode)
Singapore (CPG5)

{Singapore (Eurocode)
Thailand (ACI318, IBC)
Turkey (TS500, TBEC2018)
Turkey (TS500, TEC2007)

UK (BS8110)
UK (Eurocode) v
@ Templates: Projects
D:\chunfei\Documents\ProtaData2020\ x
[2) v X
Help oK Cancel

» Select Singapore (Eurocode) template and then OK

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Axis Creating & Storey Insertion

» Go to Modelling tab = Pick Orthogonal Axis Generator in the Modelling tab
» Pick the intersection of the primary grid near the origin (5000,5000 coordinate)

» In Orthogonal Axis Generator, change Dir-2 Axis Spacing to 5000*2 & click OK

Orthogonal Axis Generator
GridInsertion
Reference Point - x: 5000 mm -y: 5000 mm

Insertion Angle: 0.0°

Dir-1 Axes

Axis Label: |A Step: 1
Axis Spacing(s): | 5000%3
Axis Extension Length: 2000 mm
Dir-2 Axes
Axis Label: |1 Step: 1 C (»)
Axis Spacing(s): | 5000 =2

Axis Extension Length: 2000 mm

Axis Spacings. You can delimit values with comma character if unequal spadings used.
Repeating spacings may be entered using '* as multiplier, provided that spacing to be
written before number of spans. (Ex: 5000, 2000*3,4000)

(2] v X .

Help F1 OK Cancel E
X

» Right-click on Storeys in the Structure Tree and pick Add new Storey

4 H structure
b =11 Axis
4= Views
Te | Storey: 1 (Plan)
= Reports
Detail Previews
aff€
b © St0(+d E(‘ Select Storey

4 0 St1(+3|E" Insert Storey

) Columes B€ Generate Storey

- [ Ry

> Input Total No. of Storeys =2 =2 OK

» When prompted to confirm = Pick Yes = The plan view will now change focus to Storey 2

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Materials & Load Case / Combination Generator

» Go to Analysis tab > Building Analysis — Pre-Analysis tab
> Pick Edit Materials = Change the steel grade of all members to S355 (as shown below)

Steel
“o Material ped
Steel
e = General
Default Materials Concrete Columns C30/37 Grade 500 (Tvpe 2) Rebar Diameters E Material fame s
Foundation Floor i Material Color : EEO, 192, 192
4 Concrete Walls C30/37 Grade 500 (Type 2) Rebar Diameters
Mechanical Properties
Longitudinal Web Bar Grade 500 (Type 2) Rebar Diameters Modukus of Elasticty : 206182.0 Njmm2
Harizontal Web Bar Grade 500 (Type 7) Rebar Diameters Shear Modulus : 79434.0 Njmm2
Concrete Beams C30/37 Grade 500 (Type 2) Rebar Diameters Fosson's fato Lo
Thermal Expansion Coeff. 00001200 (1/°C)
Slabs £30/37 Grade 500 (Tvpe 2) Rebar Diameters Unit weght s 72500 s
Rib C30/37 Grade 500 (Type 2) Rebar Diameters Design Parameters
Links Grade 500 (Type 2) Rebar Diameters Mnimum Yield Strength : 355.00 Njnm2
Tensile Strength
Steel Columns 355
Bearing Strength
Steel Beams 5355 Material Coeff
Truss Members 5355 Standard (Norm)
Purlin Members 355
Girt Members 355 .
Brace Members 355
+ x
SI.G rey Having . ® o« oK ¥ cancel I./ #pply to all members of this material class in this storey! I
Nifferant Materi v oK HK cancel

The global materials grade of the truss, purlins, girts & brace members are shown & can be changed.

Individual member material can also be changed in their respective Section Manager dialog by
selecting the member = Right-click = Edit Section / Material.

We will now auto-generate the load cases and combination (required to add roof purlins loads).

» Pick Loading Combination to access the Load Combination Editor

Load Combination Editor

L X Loading

Add Delete Generator Load Cases

Help oK Cancel

» Pick Loading Generator =2 Pick the options as shown below =2 click OK

Automatic Loading Editor

I | Create Different Combinations for Steel Member Deswgn] V.Load Case = 5

Use Cracked Sections in All Vertical Load Combinations As Well H.Load Case = 4

Vertical Load Combinations | Horizontal Load Cominauc—ml Horizontal Load Combinations I

v| Define Dead Load Case (G)

| Define Live Load Case (Q)

v Define Pattern Loads Automatically | Apply JU%e of Uther Lirecho

vi=_=_.. ==l Add Vertical Seismic Case
L P

Direction Dependent Pattern Loading

| Notional Loading NGx, NQx, NGy, NQy

Snow Load  wO: 0.5

| Define Combinations for Roof Live Load (Qr):

Define Combinations for Snow Load (5):

Define Combinations for Rain Load (R):

» Load cases & combinations will be generated. Pick OK & Close the building analysis menu.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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Steel Columns Creation

» Click on Steel Column

[” in the Modelling

Page - 77

» In Column Properties, change Len (Storey) to 2

This means the column will span 2 storeys with effective length of
2 storey height. Thus, we do not need to model any column in

This will rotate the steel section 90 degrees on plan view.
This will launch the Section Manager dialog which allows us to

ﬂ Column End Condition : Columns ends are fixed by default. You

tab.
Column X
STOL.
Gen Drop 30
. —1- » Change the Angle of rotation to 90 degrees
oL 220 mm » Pick Section Manager icon I
o b2: 300 mm
lo] el: . . .
‘ ' = pick a section profile.
£ ed: 0 mm
Top: A 1
ﬁ Bot: A 1

icon.

I Dir: | 12 1 2

o Update |3 Close

Column Steel (UC 300x200x93)

Database Project UB 250x250x67 >
H B1 M
naroRE |v s i 25 26 29 30
175 44 44 52 59
. Eara
SHS
D 300 150 25 32 37 41 46 >
T 69
—_____| 200 48 56 57 65 77 >
T 87 106 125 130 147

» Enter eight nos of columns along Axis 1/A-D & 3/A-D

can apply hinges to top and/or bottom by clicking successively on this

In Section Manager dialog, pick Singapore

This will access to Singapore Steel Profiles
(Continental)

Pick UB 250x250x67 —> Select
Pick OK to close the dialog

:

@ ®
|
—
) " " ()
‘ (O
|
|
|
| <7
|
¢ " " ©)
|
|
|
b § \
|
|
5 - A (&) \
| \
| | \
| | \
| |
| | \
| | \
| | -~ \
L B T e e e B e o4 —(») \
L i A
1 Q) Q) N
\
\
\

<)
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» Right-click on Views in the Structure Tree and pick 3D Physical Model.

4 H structure
¥ ;J' " Axis

|

Tr | Storey: 1 (Pla Te| Plan

= Reports 30| 3D Physical Model
Detail Previews &
4 € Storeys

Analytical Model

This command will create a separate window showing the 3D view.

» Go to Views tab - Tile Vertical

This command will arrange the 3D view and plan view in 2 windows.

» Click on the Plan view to make it active (the active view title & border will be darker)

» Double-click on Storey 1 in the Structure Tree to switch focus to Storey 1

o

1) 2 3 >
A
&
G v
Column x . o .
[ ‘ 0 '
Gen Drop 3D "f/'/ ;
/
P ’
; 28§
e ® i
Len (Storey): ':}/ ”
>4
4 ’
I bi: > ,
w2 > ' Z
" &

[ el: 0mm ‘ -

‘ = ® ,

- e 0 mm e < £ 4

Top:
Bot: A 3

Bot Insertion Paint: '}

Angle: 90.0° Ve

Dir: | 12| 1 2 ey

[

(a)

+ Update ¥ Close

Click on the Steel Column icon I
Change Len (Storey) to 1 in Column Properties

Y VvV

This property means that the column will only span a single storey.
The columns with “Len = 2" are grey in STO1 because they were inserted in ST02.

Ensure the angle of rotation is 90 degrees

Pick Section Manager icon I

Ensure that the same UB 250x250x67 is selected.

YV V V V

Insert three nos. of the column along GL2/B to D.

Check the 3D view to ensure the columns were properly

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Steel Beams Creation

> Click on the 3D view to make it active (the active view title & border will be darker)

» Double-click on Storey 1 in the Structure Tree to switch focus to Storey 1.

Notice the grids will move to storey 1. This operation ensures beams to be created in St: 1 in the
3D view.

» Click on Steel Beam icon #

» Click on Section Manager L inBeam Properties

Beam Steel (UB 250x250x67)

B This will access to Singapore Steel Profiles
H B1 M .
(Continental)
26 29 30
N -E’ 44 52 59 .
I > Pick UB 250x125x25 - Select
DSH 103 2@ ¥ M % 5 pick OK to close the dialog

69
200 48 56 57 65 77

End Releases:
N V2 V3 T M2 M3
I A4

» End Releases: Click successively to hinge both ends of the beam 1 o

»
r's

» Click on the 3D view to make it active > Double-click on St: 1 to make it the active storey.

» In the 3D view, create seven nos. of beams in the region bounded by GL B, D,2 & 3 (as shown
below)

—
pM( Storey: 1(30) X

\
= ®
I |
I |
I | ;
| |
F—e—1 @ || .
l I [ \‘\\ O
| \_
@ g
| ‘\\ »
| I | y 2 x]\\ v :
| || ¥\

» Go to the plan view of STO1 = Create four nos. of UB 200x150x30 secondary beams in the region
bounded by GL B, D,2 & 3 (as shown below)

» Ensure both ends of the beams are hinged End Releases: | =4

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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—
Storey: 1 (Plan) X
e —

Use smart points to create secondary beam. With beam properties out, place the mouse cursor at the
edge of the primary beam (not center) & the smart points will appear at 0.25L, 0.33L, 0.5L & 0.75L.

Use Beams Sections Bﬂ in the Review tab to show beams of different sizes by color. Assign colors to
members in Section Manager dialog = Material Color

Steel Truss Creation

We will now insert roof trusses. Trusses are best inserted using the 3D view.

» Go to the 3D view = Double-click on St: 2 in Structure Tree to make it active & grids are at St: 2

» Click on the Truss icon 4&
= < ~ S » Pick grid intersections A/1 to define the start
S : of the truss.

A dynamic rubberband will appear with the
default truss type if no truss is defined before.

» Pick grid intersections A/3 to define the end of
the truss.

After you pick the second point, the truss
generator dialog will appear.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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- uss Generator gaad = b
General Spices Members
N s 3 B e
+ 2 - - 1 3
Import  User Defined Load From Wrre Frame Shrinked Reset oK Cancel
From DXF Truss Library View
Truss Types Patterns Label: |8
‘. Geometry A
AN NN NN N NN NS @ | oo
""" Divide Cross Diagonal Fra
Invert Truss
Enliieal s Rught Vertal Offset w 0mm
Left Cantiever Length oL 0mm
AN 5522 e =
Mode! Joints as Fixed
i | Apex
Apex Height HA 1500 mm)
Place Apex Symmetrically v
Heels
Enter Left Heel Angle By A
Left Heel Heght "
Enter Right Heel Angle By
Right Heel Height .3 00 mmi

> In Geometry, pick Duo-Pitched truss = Change Truss Support Placement to Top chord

» Change Apex height to 1500 mm, Left & Right Heel height to 800 mm

> Click on the Members tab

a2 T Truss Generator
General Splices Members
A e
F "\. x @ L '? V x
Reset Delete  Wire Frame Shrinked Reset oK Cancel
Members View
View

4 Top Chord %}’;’,";"ﬂ [ Top Center Fixed (1) Fixed (3)
12 /3% Top Center D D
13 RHS 150:75%3 Top Center O O

4 Bottom Chord Bottom Center Firced (I) Fixed (1)
14 HH UX /9K, Bottom Center |:| |:|

4 Diagonals Middle Center Fixced (1) Fixed (7)
1 SHS 75%75%3 Middle Center O O
3 SHS 75x75x3 Middle Center O O
5 SHS 75x75%3 Middle Center O O
7 SHS 75x75x3 Middle Center O O
9 SHS 75x75%3 Middle Center O O
11 SHS 75x75x3 Middle Center O O

4 Verticals Middle Center Fixed (I} Fixed (3}
2 SHS 75x75x3 Middle Center O O
4 SHS 75%75%3 Middle Center (] (]
6 SHS 75x75x3 Middle Center O O
3 SHS 75%75%3 Middle Center (] (]
10 SHS 75x75x3 Middle Center O O

» Change the truss member sections to the following by click on the section name :

e Top & bottom chord = RHS 150x75x3  (Singapore)
e Diagonals & Verticals = SHS 75x75x3  (Singapore)

» Click OK to exit the Truss Generator dialog.

The truss will be inserted. The truss insertion will automatically switch into copy mode & you can pick

the next point of insertion.

ProtaStructure’
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Purlins Creation

We will now insert purlins on the roof trusses. Purlins are best inserted using the 3D view.
>

>

automatically

found)

Click on Purlin toolbar button ek

On Purlin Dialog, you can specify the following:

e Profile / Section of the for the Purlin

Page - 82

» Insert 3 nos. of similar trusses by clicking grid

intersection B/1, C/1 & D/1

»  Press ESC or Right-Click to end the copy
operation

To enter copy mode manually, select the truss =
Right-click = Pick Copy

» Select the basepoint @ intersection of A/1

> Insert 3 nos. of similar trusses by clicking grid

intersection B/1, C/1 & D/1

Select the first truss @ GL A = Select the last truss @ GL D (Intermediate trusses will be

e Section Alignment: On the Section / Under the Section / Center

e Generation Method: By Truss Joints / By Spacing

e There are many other options. Refer to the diagrams as a guide.

e The 3D diagram on the right can be rotated (right-click & drag) & zoom in/out (mouse wheel)

EE Purlin
Label:

General

=]

Sag Rods

Load Display Mode

<

Local Axes

v | Section Properties
Profile

Section Alignment On The Top Chord
Section Alignment On The Bottom Chord

Generation Options
Placement
Generation Method

Delete First Member
Delete Last Member
Left Cantilever Length
Right Cantilever Length

o IEH

A
On The Section
On The Section

Top Chord
By Truss Joints
Default

¥ oK K cancel

ProtaStructure’

ProtaSteel’
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» Choose section UPN100 (under Steel = European sections = UPN)

Purlin Steel (PFC 100x50)

Database | Project

H

80
!
120

» In the Sag Rods dialog = Insertion Method = Choose None to remove all sag rods (for simplicity)
LL purlin

Label: 2p1 [PrC 1[5~ | 530 Rods

Insertion Method
General
Geometry
Sag Rods

» Pick OK to exit the purlins dialog.

We will insert the roof loading using the more specific Cladding function.

Creating Cladding & Loads
» Go to Modelling tab = Pick Cladding < “» 2 Select any purlin

The Cladding dialog will appear to insert roof loads on the purlins.

In the Geometry dialog, the cladding geometry can be adjusted by selecting the point and changing
the values in the vertical and horizontal direction.

e Point Horizontal Dir  Vertical Dir - N
Label: x1)8 Group 1-P1 0mm omm
Group 1-P2 omm omm
General ® |Group 1-P3 0mm omm >
Group 1-P4 0mm 0mm 4
Geometry Group 2 -P1 omm amm b
Group 2-P2 0mm 0mm q
Group 2-P3 0 mm 0mm
Group 2 -P4 0mm

v |Group3-P1 0mm

Group 3-P2 omm

P1

Group 3 -P3 0mm
Group 3 -P4 0 mm Omm| .

Load Display Mode

None
Selected

® al

Local Axes !
| Display

v K ¥ cCancel

» Click OK to exit the cladding dialog > The cladding will be rendered on top of the purlins.

» Go to the Structure Tree > Cladding > Select the cladding label

-

4 7% Claddings 1fi- Edit Loads
> Right-click > Pick Edit Loads - 1

The load editor dialog will appear, which allows you to insert area load on the cladding.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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W © {c‘:) s Cladding: 2C1 - Loads

V Y V V V V V V V

- 0 X
Load Types  View Options
"
@mlx =2 & vXx
FulUniform | Delete  Report  ZoomExtents ~ OK  Cancel
Areaload | Loads
Surface L A
] F--@ %
4 G a \ Select Members by picking or drawing a window for Load Assignment \ i =
e N o
f G2
f# G3 Bq]
o G4 X
0 G5 - 2
%
4 G-7 .
¢ GS =
69 i
fat G-10 =
£ G-11 \ I B‘[‘
fe G-12
=T
0 G-13 LJ(
ft G-14 i)
f#t G-15 . =
Load Properties
Label [G-31 4
i
Direction Gravity 111
Magnitude 0.50 kN/m2

>R

ool
]

GE:mm , Anl: kN-m , Disp:m

At the top, pick Full Uniform Area Load

Pick G Load Case in the left pane

In Load Properties, ensure Load Direction = Gravity & Magnitude = 0.5 kN/m?
Click & drag window over the entire roof cladding to apply all panels

Pick Qr Load Case (Roof Live) in the left pane & Full Uniform Area Load

In Load Properties, ensure Load Direction = Gravity & Magnitude = 0.7 kN/m?
Click & drag window over the entire roof cladding to apply all panels

Click OK to save & exit the load dialog

=
You can switch off the cladding Layer < by going to the Display tab > Layers.

This operation will make the view less cluttered & make the selection of other members easier.

Braces Creation

We will now insert some bracings between steel columns.

>
>

Click on the Brace toolbar icon X

Pick two adjacent columns at A/1 & B/1 =2 Brace Dialog will appear

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Brace
Brace Group Count Label: xi]3
Count 1
1 1 Section and Type
Align to Shorter Member Profle Leoxs
Brace Type X Brace
Out of Plane Alignment Center
Out Of Plane Offset 0mm F1-l
In Plane Alignment Original
Divide v
Model joints as fixed
..... Properties of Frame 1 (F1)
1 End x-Offset e-TX1 0 mm
1End y-Offset eTY1 0mm
. | 1End x-Offset e8X2 0mm
= e e+, i| JEnd y-Offeet eBY2 omm
i II Frame Rotation o1 -90.0 ©
T : T Properties of Frame 2 (F2)
ey | | @1y, | |1Endx-Offset eTX2 0mm
: 1End y-Offset eTY2 0mm
\ JEnd x-Offset e-BX1 0mm
€y I |l ©8Y2 | |1End y-Offset eBY1 0 mm
l | l Frame Rotation 82 %0.0° F1-J
H : Apply To Analysis
l. 1End Offsets
: g JEnd Offsets F2-J
> eax € +—
Reset View X Delete Brace v o %  Cancel

Y V

In the Brace dialog, you can specify the following:

Profile / Section of the for the braces

Brace Type (Diagonal, X Brace, Y Brace or K Brace)
Alignment & Top/Bot Offsets

Apply to analysis: offsets will affect the analytical model
Accept all defaults & click OK

Insert the same bracing between columns A/3 & B/3

Check the braces are correctly inserted, as shown below

%

a\
Va8
’Qf:\‘f |

\ \
(\A
YA
\/
0
/

(s
)

A

A\
AWY)

\/

o

» Insert new brace between columns C/3 & D/3

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Brace
Brace Group Count Label: 2%
Count 1
1 23 | Section and Type
Align to Shorter Member Profile L80X8
Brace Type
Out of Plane Alignment Center F1-1
Out Of Plane Offset 0mm
1n Plane Alignment Original
Invert
Model joints as fixed
..... Properties of Frame 1 (F1)
1End x-Offset e-Tx2 0mm
1End y-Offset e-TY2 0mm
. | JEnd x-Offset e-BX1 0mm
g ¢ JEnd yOffset eBY1
Frame Rotation e1 80,0 ©
‘ Apply To Analysis F 1 -
e 1End Offsets
JEnd Offsets E
> @gxy L‘
Reset View X Delete Brace v oK X cancel

» Change Brace Type to Diagonal

» Input J End y-Offset = 3000 mm (rest remains 0 mm)

» Tick Apply To Analysis: J End Offsets

This option will ensure the analysis frame will accurately consider this offset.

» Click OK = Diagonal Brace will be inserted

» Insert another new diagonal brace between the same columns C/3 & D/3

Brace

Brace Group Count Label: 4|3

Count 1

1 4 Section and Type

Align to Shorter Member Profiie L80x8
Brace Type Diagonal
Out of Plane Alignment Center
Out Of Plane Offset 0 mm
In Plane Alignment Original
Invert
Model joints as fixed

..... Properties of Frame 1 (F1)
1 End x-Offset e-TX1 omm
1End y-Offset eTY1
. | JEnd x-Offset e-BX2 0 mm
e ¢ | JEnd y-Offset eBr2 0mm F1
Frame Rotation o1 -90.0 °
Apply To Analysis
1 End Offsets
JEnd Offsets o
€py2
.
F1-J Lo
epxo *
Reset View X Delete Brace

v o X

Cancel

YV V VYV V

Ensure Brace Type = Diagonal

Tick Invert =2 this will invert the diagonal

The input | End y-Offset = 3000 mm (rest remains O mm)
Tick Apply To Analysis: | & J End Offsets

ProtaStructure’
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This option will ensure the analysis frame will accurately consider this offset.
» Click OK =2 A new diagonal brace will be inserted

» Check the braces are correctly created in the 3D view as below.

Horizontal braces can also be inserted between beams. Create three horizontal braces connecting the
beams in STO1, as shown below.

— » Pick 2 adjacent beams

2 Jﬂ“- = ;- - ‘N

G T L

1) —— NN S Ty g

) A4 T
7D ~Z 1A

_—_—

> In the Brace dialog, pick Brace Type =
Diagonal

» Tick / Untick Invert as required by verifying
the right-side brace diagram.

» Ensurealll & J End Offsets = 0

» Click OK

» Check the brace is correctly created as
shown in the left figure.

> Repeat the same steps to create total of 3

Model 3 horizontal horizontal braces as shown in the figure.

braces

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Girts Creation

We will now insert some girts between steel columns.

»  Click on Girt toolbar button n

»  Select the first column at grid A/3 =2 Select the last column at grid D/3.
Intermediate columns will be automatically found.

» In the Geometry dialog, you can specify the following:

e  Profile / Section of the Girt
e  Section Alignment: Under The Section / On The Section
e  Spacing, Delete Bottom / Top Member, Left / Right Cantilever, Offsets

N Girt o IEH
Label: 2G2 { | Section Properties
Profle UPN100
General Section Alignment On The Section <>

Generation Options

Geometry Fill From Top B

Sag Rods Spadng s 1000 -‘ﬂ
Delete Bottom Member
Delete Top Member -
Left Cantilever Length Le 0Omm
Right Cantilever Length Re omm
Gap Between Continuous Purlins d Omm
Offsets

Load Display Mode

Perpendicular Offset Vo 0mm

T Momb e OEEant An P

¢ oK X cancel

»  Ensure Profile is UPN100 (under Steel = European sections = UPN)
»  Ensure Section Alignment is On The Section
» Tick “Delete Bottom Member” so that bottommost Girt is removed.

In the Sag Rods dialog, you can specify the configuration of the sag rods. For simplicity, we will not
insert the sag rods for this model, as there are minor elements.

> In the Sag Rods dialog = Insertion Method = Choose None to remove all sag rods

~ Girt
Label: 2G2| %
- Sag Rods
Insertion Method None | v
General
Geometry
Sag Rods

>  Click OK, and the girts will be inserted.
» Insert similar girts between columns A/1 & C/1 but Section Alignment = Under the Section

»  Check the girts are inserted correctly at both sides of the building, as shown below

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Loads can be applied to girds similar to Purlin by creating a cladding first. For simplicity, we skip this.

Column Splice Creation

Member Spice Definitions

Splice Distance:}

Splice Width:

Enter the distance measured
storey level.

I Edit Selected Spiice

Ref, Storey No:f i1

x Delete Selected Splice

Building Analysis

» Go to the Analysis tab = Pick Building Analysis

YV V V V V

Press ESC to deselect all members

Select the corner column at GL D/3

Right-click = Define Splice

Pick Add New Splice in Splice Location Definitions
In Member Splice Definition choose :

e Reference Strorey =1
e Splice Distance (from floor level) = 800 mm
e Splice width =500mm

Click OK

The splice will be created & listed in Splice Location
Definitions.

Close Splice dialog

» In Batch Design Options, choose not the design any members =2 click Building Analysis

Once analysis is completed, the Analytical Model view will open automatically.

» Review the results in the Analytical Model view to your satisfaction as outlined in previous section.

For example, check if the roof cladding loads have been correctly considered by switching on the

Frame Loads & Frame Load Labels.

ProtaStructure” ProtaSteel
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Steel Design
Steel member design commands can be accessed via the Design tab
Building Setout Modelling Loading Review Analysis Design Drawings & Reports BIM Display Views Help
T —_— jerzzzzesf . ' v |
B O & = W <5 &g ¥ S===|I I Xz H &
Design Columns = Storey RibBeams Foundation = Slab Analysis Ribbed Slab Pad Footings Pile Caps Column Beams Slabs Ribbed Columns Beams Braces Purlins Girts  Trusses

Slabs
Deflection/Crack Check

All Beams Beams and Design Analysis Punching Check

Reinforced Concrete Steel

Design

» Go to Design tab = Design All 2 Pick Steel Member Design Check = OK

«»* This will check all the adequacy of assigned all steel members in one go.

+» The program does not automatically select the smallest section size.

«» If the model is large, it is recommended to perform design check by member types separately.
+ To access a summary of member design check, select the steel member icons in the steel

group.

» Pick steel Column Design T to access the design summary of all steel columns.

Total number of members: 11

Steel Column Design
I E EI:E 3 mark all for print .I-='I'I %
Check = Check [ Remove all printmarks  Design  Close
Selected All Repart
Member Label Storey Print | Section Material Section Class Slenderness Ratio (kLfr) Utilization Ratio
201 X W LB 250x250x67 5355 Class1 95 < 200 0.04 < 1.00
202 2 W LB 250x250x67 | 5355 Class1 95 < 200 0.11 < 1.00
203 2 W LB 250x250x67 | 5355 Classl 95 < 200 0.11 < 1.00
204 2 W LB 250x250x67 | 5355 Classl 95 < 200 0.05 < 1.00
205 2 W LB 250x250x67 | 5355 Classl 45 < 200 0,03 = 1.00
206 2 b LB 250x250x67 5355 Class1 48 < 200 0.09 = 1.00
207 2 b LB 250x250x67 5355 Class1 48 < 200 0.08 = 1.00
208 2 L LB 250x250x67 5355 Class1 95 < 200 0.04 < 1.00
ics 1 L LB 250x250x67 5355 Class1 48 < 200 0.01 < 1.00
s 1 W LB 250x250x57 | 5355 Class1 45 < 200 0.02 < 1.00
1C10 1 W LB 250x250x57 | 5355 Class1 45 < 200 0.02 < 1.00

Design Status

Pass
Pass
Pass v
Pass v
Pass v
Pass J/
Pass J/
Pass
Pass
Pass
Pass

Je)

Governing Check
(Combined)
(Combined)
(Combined)
(Combined)
(Combined)
(Combined)
(Combined)
(Combined)
(Combined)
(Combined)
(Combined)

» Double-click on any column to review the detailed design checks.
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>
>
>
for pass/fail.
>
>
>
>
Buckling length
>

Design Report =2 Prepare the design report

Click on the triangle ™ next to the title check to drill down to more details

Check Design = Re-check the design of this column

Parameters Tab > Deflection 2 Manually edit deflection limits

Page - 91
Steel Column Design - 2C1 {UB 250x250x67)
v = I [N
I o Ig.g = i b v X
Check Change Design  Show Design  Show Diagrams OK  Cancel
Design Section Report Stations
Design Summary IParameters I
2 General Parameters
Design Code: Eurocode 3 (5G)
1 Partial Resistance Factors: yMO = 1.00 yM1 = 1.00 yM2 = 1.00
Effective Length: Kx = 1.00 Ky = 1.00 Ly = 6000 mm Ly = 6000 mm Lb = 6000 mm
Section Classification
1 Section Class: Class1
»  Caboulstion Densils
Check for Combined Forces
Utilization Ratio: 0.044 <100 621(7)
[ 1 Caloulztion Detsils
hed (ki Rd (kN HplLRd (kN) U. Ratio
Secti UB 250x250x67
seton e Axial Compression: 27.97 3006.75 (CR)  3006.76 0.009
Section Width 248 mm
Section Height 248 mm Curve a Ner (ki A-bar Phi ‘Chi Nb,Rd (kN)
Flange Thickness 13 mm Buckling Major {y-y): b 0.34 5613.59 0.73 0.00 1.00 3006.78
\Web Thickness & mm Buckling Minor (z-2): = 0.49 1892.49 1.26 0.00 1.00 3006.78
Section Area 0.0085m2 Med (kiN.m) McRd (kim) MnRd (ki.m) MplRd (khm) MbRd (kN.m) Mcr(ki.m) U. Ratio
Shear Area 1 0.0065m2 Bending Major {y-y): 7.49 228,49 (LTB) 313.47 313.47 228,49 345.91 0.033
Shear Area 2 0.0020 m2 Bending Minor (z-z): 0.28 144.84(Y) 144.84 144.84 0.002
Tersional Constant +670E07 M Lateral Budding (LTB):  Curve =b aiT=0.34  AbardiT =085 O4T =093 ¥AT=0.73  Cl=100
Moment of Inertia 11 9.931E-05m4
Moment of Inertia 22 1. 345505 m4 Interaction Factors: kyy = 1.01 kyz =0.73 kzy =0.52 kzz = 1.03
Radius of Gyration 11 108 mm | | asial Compression Check
Radius of Gyration 22 63 mm o
. . Utilization Ratio: 0.011 < 1.00 +
Elastic Section Modulus 11 8.010E-04m3 - A
b Caloulstion Detsils
Elastic Section Modulus 22 2.690E-04m3

Change Section =2 Allow you to pick another section = New section will be checked automatically

Show Design Stations =2 List out all the design forces of all load combinations
Show Diagrams = Show design force diagrams for load cases, load combinations & envelope

Parameters Tab > Buckling = Input Braced length, Buckling Length Coefficient, Lateral Torsional

Effective lengths are automatically detected &calculated by the program based on restraints provided
by connected members. You can change them if you wish.

Design Summary Parameters

Buckling

Deflection

I | Manually edit the buckling parameters I

Braced Length Major, Lx:

Braced Length Minor, Ly:

Buckling Length Coefficent Major, Kx:

Buckling Length Coefficent Minor, Ky:

Distance between transverse stiffeners:

Lateral Torsional Buckling Length, Lb:

Setther

o use the aut

ted field to '0' (Zero),

atically calculated values

ProtaStructure’

» Go to the Parameter tab

» Tick Manually edit buckling parameters

Input various Braced Length

‘0" (Zero) means auto-calculate values. Hence,
only input values to over-write them.

It is highly recommended you review the auto-
calculated values and amend to suit your design

assumptions.

» Go back to Design Summary to check the design

Deflection limits can be modified using similar

steps.

>
)
1000|mm g
0 mm
0.000 <
0,000
0 mm
0 mm
o
ProtaSteel’

ProtaDetails’

ProtaBIM"




S PRoTA

» Pick OK to close the column design dialog

> Pick Trusses @2 to design the trusses

Steel Truss Design

I; I o BB X
» Mark all for print
v oL | "
Check ~ Check  [¥ Removeal printmarks Design  Close
Selected All Report
Member Label Storey Print | Section Material Section Class Slenderness Ratio (kL/r) Utilization Ratio Design Status
271 2 ' RHS 150x75x3 5355 Class1 315 > 200 0.41 Pass +
T2 2 RHS 150x75%3 5355 Class1 315 > 200 1.06 Fail X
213 2 RHS 150x75x3 5355 Class1 315 > 200 1.08 Fail x
2714 2 v RHS 150x75x3 §355 Class1 315 > 200 0.43 Pass v
» Double-click on the truss 2T2 to access the detailed steel truss design
272 - Steel Truss Design
Design
I v = o
- I x Iag = I o v x
Check Check Change Report |JReset Showlabels ShowUtiizaon] ©OK  Cancel
Selected Al Section View Ratios
Type & p
Members | Section Material Slenderness Ratio (kL/r) Deflection Utiization Ratio |  Design Status Governing Check
4 Type: Vertical o]
2F2 SHS 75x75x3 5355 43 < 200 0.05 < 1.00 Pass v (Axial Compression)
2F4 SHS 75x75x3 §355 35 < 200 0.11 < 1.00 Pass / (Axial Compression)
6 SHS 75x75x3 5355 51 < 200 0.01 < 1.00 Pass / (Axial Tension)
2F8 SHS 75x75x3 5355 43 < 200 0.05 < 1.00 Pass v (Axial Compression)
2F10  SHS 75x75x3 5355 35 < 200 0.11 < 1.00 Pass (Axial Compression)
4 Type: Diagonal
2F1 SHS 75x75x3 5355 72 < 200 0.01 < 1.00 Pass v (Axial Compression)
2F3 SHS 75x75x3 5355 67 < 200 0.09 < 1.00 Pass v (Axial Tension)
2F5 SHS 75x75x3 5355 63 < 200 0.26 < 1.00 Pass v (Axial Tension)
2F7 SHS 75x75x3 5355 72 < 200 0.01 < 1.00 Pass (Axial Compression)
2F9 SHS 75x75x3 5355 67 < 200 0.09 < 1.00 Pass (Axial Tension)
2F11  SHS 75x75x3 §355 63 < 200 0.26 < 1.00 Pass (Axial Tension) '
Selected member colored purple ]
1.00
0.257 0.85
. 0.70
o @
L 0 2 ° S o, o o
52 - S pas o%
c 5 0.50

Total number of members: 14

% V VYV V

K/
0.0

warning)

7 7 7
°n °n °n

A\

ProtaStructure’

ProtaSteel’

Pass / Failed members are shown clearly in Green / Red

Fail members (UR > 1) will be colored red in the truss diagram.

Reset View =2 Reset the truss diagram to the original orientation.
Show Label 2 Reset the truss diagram to the original orientation.

Show Utilization Ratios = Show Utilization ratio for each member.

The selected member in the table will be colored purple in the truss diagram.

ProtaDetails’

ProtaBIM"
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el

Governing Check
(Combined)
(Combined)
(Combined)
(Combined)

Slenderness Ratio failure will not result in FAIL status as it is not a critical criterion (more a

The truss diagram at the bottom can be zoomed (mouse wheel) & rotated (right-click & drag).

Double-click on the failed bottom chord member = This will bring up detailed member design
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eel r e C14 (RH:
v B I
r .""
L@ s X v X
Check Design Show Design Show Diagrams OK Cancel
Design Report Stations
Design Summary Parameters
2 General Parameters
Design Code: Eurocode 3 (SG)
Partial Resistance Factors: yMO = 1.00 yM1 = 1.00 yM2 = 1.00
Effective Length: Kx = 1.00 Ky = 1.00 | Lx=1668mm Ly =10000mm] Lb = 10000 mm
Section Classification
1 Section Class: Class1
Check for Combined Forces
Utilization Ratio: 1.056 =1.00X
» Calulation Details
Section RHS 150x75x3 | | Axial Compression Check
Section Wdih am Utiization Ratio: 1.054 > 1.00X
Section Height 150mm | | coiuistion Detais
Wall Thickness 3mm

This bottom member fails in Axial Compression Check & Combined Forces Check. You can increase the
section size or thickness to solve the failure. However, before doing that, let us review effective design

lengths. In the results, General Parameter, notice that for bottom chord, Lx = 1668 mm & Ly =
10,000mm.

e Lxis the Major Braced Length is auto determined = truss panel length
e Lyisthe Minor Braced Length is the entire length of the bottom chord between supports

Lx

(L/x\*
A g A

Ly

To reduce the minor bracing lengths bottom chord, you can add bracing members at intermediate
locations joining bottoms chords of the adjacent truss.

Alternatively, go to the parameter > Buckling tab to manually edit the bracing lengths.

> If there is a bracing member at the mid-span of the bottom chord, you can change the braced
length Minor, Ly & Lateral Torsional Buckling Length, Lb to 5000mm

» Click on Design Summary, and the member will automatically be re-checked & result in a pass

The assumption of top chord is :

e Lxis the Major Braced Length is auto determined = truss panel length
e Lyisthe Minor Braced Length is auto determined = purlin spacing

You may want to check the steel beam design. The design interface is similar to the column design.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Design Status & Design Utilization

We can view Steel Design Status and Steel Design Utilization to review pass/failure status & design
efficiency quickly.

The design status can be displayed graphically in the plan or 3D window
» Click on the 3D view to make it active

-
» Go to the Review Tab and pick Design Status M ok

Design Status

| 20

[] waming

[ exvired anaysis
[ S

[] Notoesignea

[ oo notcesign

> Click Visual Interrogation ** & choose Steel Design Utilization Ratios = OK

Active Windows Settings and Visual Interrogation Steel Design Utilization Ratios
, W10
Scene Settings Crter for recoloring; [Jo7o-08s

Entity Edges Loads " W os0-070
Beam Wall Loads [ <050
Siab Additional Dead Loads (] Notoesignea
Slab Live Loads

Hiddenline Properties

Visibiity Filters

Column Plan Display Beams with User Defined Loads

Beam Plan Display Beams using F.E. Slab Loads

Slab Plan Display Beams Using F.E. Slab Analysis Resuts
Column Nodal Loads
Column Span Loads

FE Contours

Animation Members with Temperature Difference

Design
Steel Design Utilization Ratios
Joint Shear Check
Member Performance Status
Seismic Isolators
Seismic Isolator Type

Seismic Isolator Lateral Stiffness

Seismic Isolator Axial Stiffness

OK E

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Closing Summary

Congratulations! You have created your first model in ProtaStructure.

We have created, analyzed, and designed a simple small model in this basic training guide. The
guidance provided here will give you the necessary knowledge to proceed to an actual project.

For more help and guidance, please refer to Prota Help Center: https://support.protasoftware.com

We recommend you read the What’s New document for details of new features & enhancements.

The detail drawings of all the members and the general arrangement drawings can be automatically
produced and managed in ProtaDetails (concrete) & ProtaSteel (steel). We recommend you proceed
to read the ProtaDetails & ProtaSteel Quick Start Guide as the next step.

Should you have any technical support requests or questions, please do not hesitate to contact us at
all times through globalsupport@protasoftware.com or asiasupport@protasoftware.com (Asia
Pacific).

Our dedicated online support center is available to help you get the most out of Prota’s technology
solutions with our responsive technical support team.

ProtaStructure’
ProtaSteel
ProtaDetails’
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